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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notices 

© Copyright 1998–2009 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

Acrobat®, Adobe®, and PostScript® are trademarks of Adobe Systems Incorporated. 

HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in both 32- and 64-bit configurations) on

all HP 9000 computers are Open Group UNIX 95 branded products.


Intel®, Itanium®, and Pentium® are trademarks or registered trademarks of Intel Corporation or its 

subsidiaries in the United States and other countries.


Java™ is a U.S. trademark of Sun Microsystems, Inc.


Microsoft®, Windows®, and Windows NT® are U.S. registered trademarks of Microsoft Corporation.


Oracle is a registered trademark of Oracle Corporation and/or its affiliates.


UNIX® is a registered trademark of The Open Group.


X/Open® is a registered trademark, and the X device is a trademark of X/Open Company Ltd. in the UK and 

other countries.
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Documentation Updates 

This guide’s title page contains the following identifying information: 

• Software Version number, which indicates the software version. 

• Document Release Date, which changes each time the document is updated. 

• Software Release Date, which indicates the release date of this version of the software.


To check for recent updates, or to verify that you are using the most recent edition of a document, go to:


http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 
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Support 

You can visit the HP Software Support Online web site at: 

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers. 

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the HP Software Support web site to: 

• Search for knowledge documents of interest


• Submit and track support cases and enhancement requests


• Download software patches


• Manage support contracts


• Look up HP support contacts


• Review information about available services


• Enter into discussions with other software customers


• Research and register for software training


Most of the support areas require that you register as an HP Passport user and sign in. Many also require a

support contract.


To find more information about access levels, go to:


http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 
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1 Introduction to the HP Operations Smart Plug-in 
for SAP 
This chapter provides an overview of the basic concepts necessary to understand the HP 
Operations Smart Plug-in for SAP (SPI for SAP). The information in this section describes 
how the SPI for SAP integrates with HP Operations Manager (HPOM) for Windows and other 
HP software products and helps you understand how to customize both the SPI for SAP and 
other HP software products to meet the needs of your environment. 

The SPI for SAP is a software package linking SAP NetWeaver to HPOM. The union offers a 
complementary and consolidated view of SAP performance information and overall resource 
characteristics. 

This integration allows the correlation of SAP performance data with the performance data of 
the operating system, the database, and the network—all from one common tool and in one 
central management system. Integrating SAP performance data with the HPOM 
environment helps you detect and eliminate bottlenecks in a distributed environment. In 
addition, the integration allows for system optimization and service-level monitoring. The SPI 
for SAP performs the following tasks in a distributed HPOM environment: 

•	 Collects real-time information about events and configuration—including useful on-line 
instructions for fast problem resolution 

•	 Monitors SAP nodes to detect potential problem areas and keep track of systems and 
events 

•	 Collects performance data to ensure system throughput and notifies you of any 
performance bottlenecks 

•	 Provides a direct, context-sensitive access to the SAP front-end 

•	 Complements and extends the SAP Computing Center Management System (CCMS) 

•	 Stores events and action records for all SAP managed nodes into a central repository 

•	 Runs routine SAP management tasks 

•	 Integrates SAP environments with the service map—the SPI for SAP includes a policy 
that automatically generates service views of the SAP systems installed on your managed 
nodes. 
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Components of the SPI for SAP 

The SPI for SAP components include tools and policies that allow you to configure and receive 
data in the form of service problem alerts, messages, and metric reports. The SPI for SAP 
service map alerts are shown in the HPOM service map, while SPI for SAP messages and 
automatic action reports are available through the HPOM message browser. 

Tools 

In conjunction with HPOM, the SPI for SAP offers centralized tools, that help you monitor 
and manage the SAP systems. The SPI for SAP tools enable you to configure the management 
server’s connection to selected server instances on specific managed nodes. The SPI for SAP 
tools include the tools for administrating and operating the SPI for SAP. 

The following are the SPI for SAP tools: 

•	 SAP R/3 Admin - SAP R/3 Administration of Global Configuration. 

•	 SAP R/3 NT - Tools for Windows managed nodes. These are only a subset of the Tools 
available for UNIX nodes. 

•	 SAP R/3 UN*X - Tools for UNIX managed nodes. Some tools are also available for 
Windows nodes. 

For more information on Tools, see Using SPI for SAP Tools on page 47. 

Policies 

SPI for SAP consists of policies that monitor the SAP systems. The policies contain settings 
that enable incoming data to be measured against predefined rules. These rules generate 
useful information in the form of messages. The messages have color-coding to indicate the 
severity level. You can review these messages to analyze and resolve the problem. There are 
several pre-defined corrective actions for specific events or threshold violations. These 
corrective actions can be triggered automatically or operator-initiated. Monitoring comprises 
of generating alarms related to critical events of the tool, and logging important performance 
metrics of the application server. 

The SPI for SAP creates the following policy groups/sub groups and configuration files under 
the en folder. 

•	 SAP NW Java Monitoring 7.0 

•	 SAP NW Java Monitoring 7.1 

•	 SAP R3 6.x/7.0AS/7.1kernel 

•	 SAP R3 6.xCI 

•	 SAP R3 7.0CI/7.1kernel 

For more information on policies, see Using and Customizing the SPI for SAP Policies on 
page 51. 

Reports 

SPI for SAP reports are web-based reports that are produced by HP Reporter (Reporter) using 
the default templates and viewed using a web browser. You can request both scheduled and 
on-demand versions of reports using Reporter. 
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SPI for SAP service reports correlate the data extracted from either the HP Software 
Embedded Performance Component (CODA) or the HP Performance Agent. You can use the 
correlated data to generate reports which display short-, medium-, or long-term views of your 
IT environment and supplement the detailed, real-time graphs that the Performance 
Manager provides. You can use these reports for trend analysis. For more information on 
Reports, see Integrating the SPI for SAP with HP Reporter on page 101. 

Functions of the SPI for SAP 

The SPI for SAP provides you with a centralized problem-management environment with HP 
Operations agents on the SAP NetWeaver managed nodes. The use of the central HP 
Operations management server avoids the duplication of administrative effort. 

Server Performance and Availability Information 

Availability management alerts you when something in your SAP NetWeaver environment is 
going wrong, for example: a disk is full or a key process has either stopped prematurely or 
failed to start at an appropriate time. The combination of the SPI for SAP and HPOM alerts 
SAP administrators about such conditions and provides the following additional assistance in 
the alert message: 

• Advice about corrective action that should be taken 

• A pre-defined action that the administrator can initiate. 

• An automatic action, such as an e-mail message to a manager if a critical condition occurs 

Display Information 

The SPI for SAP policies generate messages when a threshold is exceeded. These messages 
can appear as: 

Messages in the Message Browser– HP Operations Agent software compares the values 
gathered for the performance and availability of SAP against the monitor policy related to 
those specific areas. The agent software then forwards appropriate messages to the HPOM 
console. These messages appear with color-coded severity levels in the HPOM message 
browser. 

Instruction Text– Messages generated by the SPI for SAP programs contain instruction text 
to help analyze and solve problems. You can manually perform corrective actions preassigned 
to events or they can be triggered automatically. 

Instruction text is present in the Message Properties window. To view the text, right-click the 
message, select Properties, and chose the Instructions tab. 

Metric Reports– In addition to the instruction text, some messages cause automatic action 
reports to be generated. These reports show conditions of a specific SAP instance. If a report is 
available, you can view it by clicking the Annotations tab in the Message Properties window. 

Generating Reports using HP Reporter 

You can integrate the SPI for SAP with HP Reporter to provide you with management-ready, 
web-based reports. The SPI for SAP Report package includes the policies for generating these 
reports. You can install the Report package on the Reporter Windows system. 
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After you install the product and complete basic configuration, by default, Reporter generates 
reports of summarized, consolidated data every night. You can use these reports to assess the 
performance of the system over a period of time. 

Customizing Policies and Metrics 

You can use the SPI for SAP policies without customization, or modify them to suit the needs 
of your environment. Some of the modifications and customizations that you can do are the 
following: 

•	 Modify the default policies - Within a policy, you can change the default settings for: 

—	 Collection interval 

—	 Threshold 

—	  Message text 

—	 Duration 

—	  Severity level of the condition 

—	 Actions assigned to the condition (operator-initiated or automatic) 

•	 Create custom policy groups – You can create custom policy groups using default policies 
as base. For more information, see Using and Customizing the SPI for SAP Policies. 

•	 Create custom metrics– You can define your own metrics or User Defined Metrics (UDMs) 
to expand the monitoring capabilities of the SPI for SAP. For more information about 
UDMs see the HP Operations Smart Plug-in for User Defined Metrics User Guide. 
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2 Installing or Upgrading the SPI for SAP

This chapter provides the information you need to check the suitability of your systems for the 
installation of the Smart Plug-in for SAP. 

Installation Packages 

The following are the SPI for SAP packages available in the HP Operations Smart Plug-ins 
DVD. 

SPI Package 

The core package is the HP Operations Smart Plug-ins.msi contains all the SPI functionality. 
The package must be installed on a server managed by HPOM. The SPI for SAP package is 
available at the following location on the media: 

<SPI DVD>\SPIs\SAP SPI\SPI-SAP-ITO.msi 

Reporter Package 

This package contains the default reporter templates provided by SPI for SAP. These 
templates are static and cannot be modified unless Crystal Reports 10.0 or later is installed. 
The Reporter gathers the data from the nodes managed by SPI for SAP through HPOM 
server, stores it in its local database, and then creates .html reports based on the default 
report templates. The SPI for SAP reporter packages are available at the following location on 
media: 

<SPI DVD>\SPIs\SAP SPI Reporter Package\sapspi_reporter.msi 

Console Package 

This package contains SPI for SAP utilities that need to be installed on a server running as 
Console. To enable a remote console so that users can run Tools, SPI for SAP utilities must be 
installed on the console. The SPI for SAP console package is available at the following location 
on media: 

<SPI DVD>\SPIs\SPIs Console Packages\SPI-SAP-ITO-CONSOLE.msi 
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Installation Environments 

Standard Installation of SPI Components on an HPOM Server 

By using the HP Operations Smart Plug-ins DVD you can select to install only SPI for SAP 
packages and not the reporter and graphing packages. However, if the full version of Reporter 
or Performance Manager is installed on the same system, the corresponding packages can be 
installed or uninstalled on the HPOM server. 

Standard Installation on Remote Consoles 

All the Remote Console packages on the SPI DVD including the SPI for SAP are installed at 
once on to remote consoles. No option is provided to select a particular remote console package 
if you use SPI DVD media to install the console package. 

Standard Installation in the HPOM Cluster Environment 

In an HPOM cluster environment, you must have installed the HPOM server on each of the 
systems in the cluster. You can install SPI on each of the nodes in the cluster environment. 

Standalone HP Reporter and HP Performance Manager 

For such a machine only the corresponding package of any SPI is enabled and available for 
selection from the HP Operations Smart Plug-Ins DVD. For example, if a system has only HP 
Reporter installed, the reporter package of any SPI could be installed on it. The same applies 
to the graphing package and HP Performance Manager. 
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Installation Overview 

The following flowchart summarizes the steps for installing, upgrading, and configuring the 
SPI for SAP. 
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Installation Prerequisites


For the SPI for SAP to run properly, your system must meet the requirements described in 
this section. 

Before You Begin 

Before installing the SPI for SAP, make sure you perform the following checks: 

•	 Ensure that the systems on which you want to install the SPI for SAP software meet the 
requirements listed in the following sections: 

—	 Hardware, Operating System, and Disk Space Requirements on page 16. 

—	 Software Requirements on page 17. 

•	 For each SAP instance, note the following: 

—	 Which SAP version is installed? 

—	 Is SAP installed on a central instance or an application server? 

•	 Create a list of all the SAP clients you want to monitor with the SPI for SAP. For each 
client, list the following data: 

—	 The hostname of the SAP application server 

—	 The SAP system ID 

—	 The SAP Instance number 

—	 The SAP client number 

—	 The operating-system platform (UNIX, Linux, or Microsoft Windows) 

— User name/password to be used for monitoring


Use this information to set up the environment for the SPI for SAP.


Hardware, Operating System, and Disk Space Requirements 

Before you install the SPI for SAP, use the information provided in Table 1 to ensure that 
your systems (HPOM management server and all the managed nodes) meet the requirements 
for hardware, software, operating-system support, and disk space. 

Table 1	 Hardware, Operating System, and Disk Space 
Requirements 

Product Operating Systems Minimum Disk Space 

SPI for SAP on the • Windows Server 2003 1 GB 
management servera •	 Windows Server 2008 

(only on x64) 
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Table 1 Hardware, Operating System, and Disk Space 
Requirements (cont’d) 

Product Operating Systems Minimum Disk Space 

SPI for SAP on managed 
nodes 

HP-UX Approximately 40MB.b 

The disk-space 
requirement on the node 
will increase with the 
amount of data collected 
and logged by the SPI. 

AIX 

Windows 

Linux 

Solaris 

SPI for SAP Reporter 
Package 

Windows 1 GB 

a.	 On the management server, make sure that the PATH system variable includes the locations 
of Windows utilities/commands and Windows Script Host. 

b.	 Includes 5MB for the transports 

Support Information: Detailed information on supported operating systems is available in 
the Support metrics available at http://support.openview.hp.com/selfsolve/document/ 
KM323488 

Software Requirements 

Before you configure or upgrade the SPI for SAP, use the information provided in Table 2 on 
page 17 and Table 3 on page 18 to ensure that you are using a version of HPOM that is 
compatible with the current version of the SPI for SAP. In addition, you will need to ensure 
the following: 

•	 The HP Operations agent software must be available on the HPOM management server 

•	 The standard HPOM management-server policies must be available on the HPOM 
management server 

•	 HP Reporter must be available if you want to view service reports for SAP. 

HP Reporter lite is no longer bundled with HPOM; install the HP Reporter 
product to generate reports from the data collected by the SPI for SAP. 

If you want to edit existing (or create new) reports for the SPI for SAP, make sure that 
Crystal Reports (version 10.0 or later) is available on the machine hosting the HP 
Reporter (version 03.80 or later). 

•	 To generate graphs from the data collected by the SPI for SAP, you must install HP 
Performance Manager in the HPOM environment. 

Table 2 lists the software versions for the HPOM management server, which the current 
version of the SPI for SAP supports. 

Table 2 Supported HPOM Management-Server Platforms 

HPOM Version a Operating System Platform 

08.10 • Microsoft Windows Server 2008 (only x86) 
• Microsoft Windows Server 2003 
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a. Installed systems should be patched to the latest required 
level 

Table 3 on page 18 shows which combinations of the SAP kernel and (in brackets) the SAP 
Basis versions of SAP the SPI for SAP supports. Note that the last three columns reflect a 
change to the SAP version-numbering system and show the SAP basis version and (in 
brackets) the SAP kernel version. For example, 6.40 (6.40) means SAP basis 6.40 (SAP kernel 
6.40). 

Table 3 Supported Managed-node Platforms and SAP Versions 

SAP Basis 
(Kernel) 

Managed-Node 6.40 7.0 7.1 
Operating System (6.40) (7.0) (7.1) 

AIX • • • 

• • •HP-UX 

Linux • • • 

• • •Solaris 

Windows • • • 

You must install the latest version of the Microsoft .NET Framework on all Windows nodes. 

Obsoleted Software Versions 

The following, features, software, or operating systems are no longer supported with this 
version of the SPI for SAP: 

•	 SAP R/3 4.6C kernel (4.6C with 4.6D kernel support is dropped) 

•	 SAP ITS 4.6/6.10/6.20 

•	 HP-UX 11.00 

•	 r3monsap, the CCMS 3.x alert monitor used with SAP R/3 3.1- 4.5 

•	 r3monxmi, the SAP System-log monitor (replaced by r3monal for 4.6C and later) 

•	 r3monits, the SAP ITS 6.20 monitor 

•	 The SPI for SAP no longer provides support for the Windows 2000, 2000 Advanced Server 
operating systems on either the HPOM management server or the managed node. 

The current release of the SPI for SAP no longer provides support for the HP-software 
Self-healing Services (SHS) feature, which is now obsolete. 
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Installing the SPI for SAP Software 

Before you install and configure the SPI for SAP software, make sure that you install HPOM 
and patch it to the latest required level. After completing the installation of HPOM, use the 
HP Operations Smart Plug-ins DVD to install the SPI for SAP software. 

Support Information: Detailed information on supported operating systems is available in 
the Support metrics available at http://support.openview.hp.com/selfsolve/document/ 
KM323488. 

When you install the SPI for SAP on a management server or console system, follow these 
steps. 

Installing Smart Plug-in for SAP on the Management Server or Console 

1 Insert the HP Operations Smart Plug-ins DVD into the DVD drive of the management 
server or console system. The Installation Wizard opens. 

2 Click Next to continue. The Smart Plug-ins Release Notes and Other Documentation 
screen appears. 

3 Click Next to proceed. On the Program Maintenance screen, select Install Products. 
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4 In the Product Selection screen, select the SPI for SAP to install or upgrade. 

If HP Reporter is installed in the environment, you can select the Reports check box. 

If latest version of SPIs is already installed, SPI checkboxes are disabled. If 
Reporter is not installed, Reports checkbox is disabled. 

5 Click Next. The Enable/Disable AutoDeployment screen appears. 

6 Select an option to disable or enable the Auto Deployment feature. 

7 Click Next. The License Agreement screen appears. 

8 Indicate your acceptance of licensing agreement terms by selecting the I accept the 
terms in the license agreement button and click Next. 
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9 Click Install to begin the installation. 

Selecting the Cancel button after the installation has started does not halt the entire 
installation process, but only that of the product currently being installed (shown in the 
Status area); installation of the next selected product then begins. 

You will see various status dialogs as the install program proceeds. Depending on the speed of 
your system and the components selected for installation, this process could take several 
minutes or more. 

10	 Click Finish to conclude the installation. 

Installing the SPI for SAP on a Remote Console 

You can follow any of the following approach to install the SPI on a remote console. 

•	 Using SPI DVD media 

•	 Using the SPI for SAP console package 

Using SPI DVD media 

You can use the SPI DVD at the remote console to install the all SPI packages that are located 
at <SPI DVD>\SPIs\SPIs Console Packages on the SPI DVD media by performing the 
following steps. 

1	 At the console-only system, insert the HP Operations Smart Plug-ins DVD. 

2	 Follow the instruction screens until a dialog appears saying that a remote console 
installation has been found. 

3	 Click Next. 

The upgrade of all previously installed packages now occurs. 

Using the SPI for SAP console package 

1	 Install the SPI for SAP integration for the HPOM console on any additional system where 
you intend to run the HPOM console remotely in combination with the SPI for SAP. The 
SPI DVD Installer does not install the console-integration package automatically on 
remote systems; you have to install the package manually by locating the 
console-integration package file and double-clicking it to launch the set-up program. You 
can find the console-integration package on the HP Operations Smart Plug-ins DVD in the 
following location: 

<DVD>\SPIs\SPIs Console Packages\SPI-SAP-ITO-CONSOLE.msi 

Before continuing with the configuration of the SPI for SAP software ensure the installation 
process completed correctly by following the instructions listed in Verifying the Installation of 
the SPI for SAP Software on page 24. 

Remote Monitoring with the SPI for SAP 

You can extend the scope of the SPI for SAP to monitor the status of SAP NetWeaver on 
remote SAP servers, which are not managed nodes and where the SPI for SAP is not installed. 
You can set up and perform the remote monitoring from a managed node, where the SPI for 
SAP software is installed, correctly configured, and running. 
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You can use the remote-monitoring feature provided by the SPI for SAP to monitor an SAP 
System running in an environment that is not supported by the SPI for SAP, for example; a 
mainframe environment. 

You can use the alert-classes section at the end of the monitor-configuration file to associate 
an instance of a monitor with a specific host, SAP instance, or processes on the remote server 
in the same way as you can with a normal (local) managed node. For more information about 
the remote-monitoring feature, see the HP Operations for Windows Smart Plug-in for SAP 
Administrator’s Online Help. 

Upgrading the SPI for SAP 

You can upgrade the SPI for SAP by using either of the following: 

•	 Upgrade using the SPI Upgrade Toolkit 

•	 Upgrade using the HPOM console 

Upgrade using the SPI Upgrade Toolkit 

The HP Operations Smart Plug-in Upgrade Toolkit (SPI Upgrade Toolkit) helps you upgrade 
HP Operations Smart Plug-ins to a higher version while retaining the customizations done on 
policies. During the SPI for SAP upgrade process, the SPI Upgrade Toolkit enables you to 
store the modifications done on the customer version of policies. For a specific policy, the SPI 
Upgrade Toolkit analyzes and compares three versions—base, customer, and factory. It helps 
you select the settings of the base, customer, or factory version of the policy—depending on 
your requirement. 

To upgrade the SPI for SAP using the SPI Upgrade Toolkit, follow the instructions in the HP 
Operations Smart Plug-in Upgrade Toolkit Windows User Guide. 

Upgrade using the HPOM Console 

This section describes how to upgrade the SPI for SAP software from version 10.70, 11.10 to 
version 12.00. Before you upgrade the SPI for SAP software, read through the 
recommendations below. 

1	 Ensure you have read and understood the requirements in Hardware, Operating System, 
and Disk Space Requirements on page 16. 

2	 Use a backup facility to save the complete, current configuration. This enables you to 
restore the configuration in the event that the upgrade is unsuccessful. 

3 Make safety copies of any configuration-file templates that contain modifications you 
made to the original configurations. Note the location of the policy templates: 

%OvShareDir%\SPI-Share\sapspi 
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4 Although policies are protected by the version system, it is always a good idea to backup 
the SPI for SAP policies, which you have deployed to the managed nodes. If you have 
modified any of the SPI for SAP message-source policies, create a safety copy of the SPI 
for SAP policy group and all the policies it contains. 

You cannot simply overwrite the new policy templates delivered as part of the SPI 
for SAP version 12.00 with the backup copy of the previous template version: you 
have to merge any changes you made to the old policy templates into the new policy 
templates. Since the SPI for SAP includes revised and improved policy templates, 
overwriting them with an older version can result in unmatched messages and 
might even cause more serious problems. 

5	 If you are using (and want to upgrade) the SPI for SAP R/3 Performance Agent, you need 
to remove the old SPI for SAP performance monitor sub-agent from the managed nodes 
before you remove and upgrade the SPI for SAP. Read the section Upgrading the 
Performance Monitor on page 77 before continuing with the next step, which concerns the 
removal of the old SPI for SAP software. 

6	 Install the new SPI for SAP software on the HPOM management server according to the 
instructions provided in Installing the SPI for SAP Software on page 19. 

The set-up process removes the existing SPI for SAP software on the management 
server and replaces it with the newer version. 

7	 Install the SPI for SAP integration for the HPOM console on any additional system where 
you intend to run the HPOM console remotely in combination with the SPI for SAP. The 
SPI DVD Installer cannot perform this step automatically; you must perform this step 
manually by locating the console-integration package and double-clicking it to launch the 
set-up program. 

If the setup program finds an existing SPI for SAP console-integration package, it 
removes it and replaces it with the newer version. 

For more information about the location of the console-integration package, see Installing 
Smart Plug-in for SAP on the Management Server or Console on page 19. 

8	 Configure the SPI for SAP to monitor SAP as described in Configuring SAP-Specific Tasks 
on page 29. These instructions take you through the process of setting up SAP to allow 
access to the SPI for SAP monitors and configuring the SPI for SAP monitors to look for 
and report the information you want to see. 

9	 Configure the SPI for SAP to work with HPOM as described in Configuring HPOM 
Administration Tasks on page 39. These instructions take you through the process of 
deploying the SPI for SAP instrumentation and policies. 

10	 Upgrade the SPI for SAP R/3 Performance Agent. 

Before converting any data, read the instructions in Upgrading the Performance Monitor 
on page 77 and, in addition, in the section about upgrading the SPI for SAP R/3 
Performance Agent in the SPI for SAP Online Help. 

When upgrading SPI for SAP from a previous version to the 12.00 version, perform 
the actions in the following order: 

1 deploy the instrumentation 
2 deploy all the configuration files except r3itosap.cfg file. 
3 deploy the scheduled policies. 
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Upgrading the SPI for SAP on a local management server 

Verify you have met the prerequisite: On the console or management server, verify that 
you have installed HPOM 8.10. 

For purchased, evaluation, and complimentary SPIs: Upgrading SPIs that you 
purchase or are complimentary is the same as a new installation. Before starting, review the 
SPI documentation which describes in detail any steps required before upgrading SPIs. By 
completing all required steps, you avoid unnecessary data loss. 

Verifying the Installation of the SPI for SAP Software 

It is recommended that you carry out a number of simple checks to verify that the installation 
of the SPI for SAP software has completed successfully and that all the required elements are 
available before you continue with the configuration of the software. 

To Verify the Installation of the SPI for SAP Software, follow these steps: 

1 In the HPOM console, browse to the following item: 

Tools > SPI for SAP 

Check that the following sub-directories are present: 

— SAP R/3 Admin 

— SAP R/3 NT 

— SAP R/3 UN*X 

2 Click each sub-directory in turn to confirm tools are present as illustrated in Figure 1. 

Figure 1 SPI for SAP tools sub-directory 

3 Although the SPI for SAP does not install them, you should check that the ConfigFile 
policy packages are available, since they are required. In the HPOM console tree, browse 
to the following item: 

Policy management > Deployment packages 
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The following items (belonging to the configuration-file policy type) should be present as 
illustrated in Figure 2. 

— ConfigFile Policy Package for DCE Nodes 

— Operations-agent 

Figure 2 Check the Installed packages 

Installing the SAP GUI 

In this step, you install the SAP GUI on the HPOM management server as well as on the 
machines where you want to run a HPOM console. You should use your SAP installation 
media to install the most recent version of the SAP GUI available in your environment. Most 
of the operator-initiated actions and tools included in the SPI for SAP start the SAP GUI to 
access and display SAP information. For this reason, a SAP GUI must be available on the 
machine hosting the HPOM management server and, in addition, on any system where you 
want to run a remote HPOM console. For more information about installing the native GUI 
for SAP, see the appropriate SAP documentation. 

Downloading SAP Libraries 

You must download the necessary SAP RFC libraries on the management server. To download 
the SAP RFC libraries, follow these steps: 

1 Create the following folder on the management server: 

C:\temp\Sap_RFC_Downloads\Libraries 
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2 Inside the newly created Libraries folder, create the following folder structure. 

a Create the Libraries folder under the C:\temp\Sap_RFC_Downloads folder. 

b Under the Libraries folder, create the Windows, Linux, Sun, HPUX, and Aix folders. 

c Under the Windows folder, create the 32bit and x64 folders. 

d Under the Sun folder, create the sparc folder. 

e Under the Aix folder, create the x64 folder. 

f Under the HPUX folder, create the IPF64 and PA folders. 

g Under the Linux folder, create the x64 and IPF64 directories. 

3 Download the appropriate flavors of the RFC SDK 6.40 from the SAP Software 
Distribution Center website (http://service.sap.com/swdc). 

Regardless of the version of SAP deployed in your environment, always download 
the RFC SDK version 6.40. 

Extract the contents of the RFC SDK and copy the library files into the directories created 
in step 2 as listed in the following table: 

Table 4 SAP Libraries 

Node Platform Library File Copy into the Folder 

Windows 32-bit librfc32.dll /Windows/32bit 

Windows X64 librfc32.dll /Windows/x64 

Linux librfccm.so /Linux 

Linux librfccm.so /Linux/x64 

Linux librfccm.so /Linux/ipf64 

Solaris librfccm.so /Sun/sparc 

HP-UX IA-64 librfccm.so /HPUX/IPF64 

HP-UX PA-RISC librfccm.sl /HPUX/PA 

AIXa librfccm.so /Aix/x64 
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a. For all supported flavors of AIX, use the AIX 64-bit RFC SDK (6.40). 

4 After placing the library files into the newly created folders, run the Install the RFC 
Library tool on the management server from the SAP R/3 Admin tool group. 
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3 Configuring SAP-Specific Tasks

This section describes how to complete the SAP-specific part of the installation of the Smart 
Plug-in for SAP. The tasks in this phase require knowledge of SAP transactions and specific 
monitoring requirements. You will be working with the HPOM console as well as on the SAP 
system application servers and will need to log on to HPOM as an operator and to the SAP 
clients as a user with authority to perform the SAP tasks included in this phase. 

After you set up and deploy the configuration-file policies, you must also deploy the 
corresponding Smart Plug-in for SAP policies to the SAP managed nodes. See Deploying SPI 
for SAP Policies to Managed Nodes on page 43. 

Applying the SAP Transports 

In this step, you copy the transport files provided by the Smart Plug-in for SAP to the SAP 
transport directories on each HPOM managed node that is an SAP central instance. 

The SPI for SAP Transports 

The SPI for SAP provides a number of different transport files. Since the transports contain 
monitors that serve a specific purpose, it is important to understand where each transport 
needs to be imported and why. The SPI for SAP contains the following transports: 

• R3Trans.car 

The R3Trans.car transport contains all the ABAP monitors that the SPI for SAP uses 
along with the default configuration settings; you import the R3Trans.car transport into 
each of the SAP’s central monitoring system which monitors all the satellite systems 
connected to it through the r3monal monitor. 

• SAPSPI_CCMS_Monitors.car 

The SAPSPI_CCMS_Monitors.car transport adds the SPI for SAP’s CCMS-based 
monitors for J2EE, System security, standalone-enqueue servers, the Enterprise-Portal, 
and XI monitoring to the CCMS monitor set HP OV SAP-SPI. You import the 
SAPSPI_CCMS_Monitors.car transport either into the individual SAP systems whose 
CCMS alerts you want to monitor with the SPI for SAP or, if configured, into the central 
monitoring system (CEN). In SAP terms, the CEN is the system you configure as the 
central management point of control for any CCMS alerts originating from anywhere in 
the monitored SAP landscape. 

For more information about the SPI for SAP monitors as well as instructions for modifying 
existing (or adding new) monitors to standard SPI for SAP monitor sets, see the SPI for SAP 
Online Help. 
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SAP Transport Naming Conventions 

The SPI for SAP provides transports for supported SAP versions that include SPI for SAP 
functionality in the SAP name space "/HPOV/". As a result of this naming convention, 
administrators now must use the new SPI for SAP name-space transports if they want to use 
the SPI for SAP to monitor SAP Systems. For more information about the SAP versions that 
the SPI for SAP supports, see Installation Prerequisites on page 16. 

It is possible to import the new SPI for SAP name-space transport into an SAP System 
where previous versions of SPI for SAP transports have already been imported. 

Table 5 lists the naming conventions used for the transport objects provided by the SPI for 
SAP. 

Table 5 Naming Conventions for Transport Objects 

Transport Class 

Table of Contents 

Development Class 

Domain 

Function Groups 

Function modules 

Programs 

Roles 

Transport Object 

/HPOV/ZHPSPI0* 

/HPOV/SAPSPI 

/HPOV/ZITO_* 

/HPOV/NW04 
/HPOV/ZBTO 
/HPOV/ZLPO 
/HPOV/ZSPA 
/HPOV/ZSPB 
/HPOV/ZSPY 
/HPOV/WEBAS 
/HPOV/WEBAS70 
/HPOV/SOLMAN 

/HPOV/OV_* 

/HPOV/YSPI* 
/HPOV/ZHPSPIB1 
/HPOV/ZHPSPIB2 
/HPOV/ZHPSPIT1 
/HPOV/ZHPSPI00* 

/HPOV/SAPSPI_MONITORING* 
/HPOV/SAPSPI_SECURITY_MON 

To copy the SPI for SAP transport files to the managed nodes, follow these steps: 

1 Use the Windows Explorer tool to locate the SAP transport packages, which by default 
reside in the following directory on the HPOM management server: 

%OvShareDir%\Packages\SAPTransports 

The SAP transport package is stored in the SAP-specific .car format and is accompanied 
by a readme file explaining which SAP transports you must import into each SAP version. 
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2 Use the ftp method to transfer the package to each of the SAP central instances you want 
to manage with HPOM. 

The operating-system user executing the ftp operation requires write permission 
in the transport directory. If necessary, enable write access to the transport 
directory manually. 

3 On each of the managed nodes, as SAP administrator (<SID>adm) use the CAR (or 
SAPCAR) command to unpack the transport files to /usr/sap/trans. Enter: 

•	 CAR -xvf R3Trans.car


R3Trans.car contains the SPI for SAP’s ABAP monitors.


•	 CAR -xvf SAPSPI_CCMS_Monitors.car 

SAPSPI_CCMS_Monitors.car contains the transport files for the SPI for SAP’s 
CCMS-based monitors. 

•	 For more information about the SPI for SAP’s transports, see The SPI for SAP 
Transports on page 29. For more information about the SPI for SAP’s CCMS monitors, 
see SPI for SAP Online Help. 

The SAPCAR command is available on any SAP Kernel CD and replaces the CAR 
command in versions of SAP from 4.6. 

4	 Continue importing the SAP transport files following the instructions described in the 
following sections; you can use either the command line or the SAP GUI. 

To Import Transport Files using the Command Line, import the Smart Plug-in for SAP 
transport to your SAP central instance. For example, enter the following commands as SAP 
administrator (<SID>adm) on the appropriate HPOM managed node: 

cd \usr\sap\trans\bin

tp addtobuffer <transport_file_name> <SID> 

tp import <transport_file_name> <SID> client=<client_number>


In this example, <SID> is the SAP system ID and <transport_file_name> is the name of 
the transport file, which corresponds to the version of SAP running on the HPOM managed 
node, for example: 

tp addtobuffer SPIK900132 CIA 

The transport file name, SPIK900132, and the SAP System ID, CIA, are used here only to 
illustrate the correct syntax for the tp command. For more information about transport 
numbers and SAP versions, see the following file on the HPOM management server after 
installation of the software bits: 

%OvShareDir%\Packages\SAPTransports\readme 

If the tp command indicates that it cannot find files or required information, use the 
pf=<path>\TP_DOMAIN_<SID>.PFL option to define the location of the tp-parameters file. 
In the following example, we assume that you installed SAP in the e:\ partition: 

pf=e:\usr\sap\trans\bin\TP_DOMAIN_<SID>.PFL 

If for any reason an error occurs, you can clean the buffer using the following command: 

tp cleanbuffer <SID> 

Repeat this procedure on each SAP system you want to manage with HPOM. 
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Alternatively, you can import transport files with the SAP GUI. To import transport files 
using the SAP GUI, follow these steps: 

1 Log on to all SAP Systems where you want to apply the SPI for SAP transport file. 

Transports must be applied to each SAP System. 

2 In the SAP GUI, enter the following transaction ID to display the SAP Transport 
Management System (SMTS) login page: STMS 

3 In the SAP Transport Management System login page, click the Transport icon (or press 
the F5 function key). 

4	 Select the SID of the SAP System into which you want to import the SPI for SAP 
transport. 

5	 In the file menu, click Extras > Other requests > Add. 

6	 In the Transport-Request-to-Import queue, enter the following: 

<Transport_file_name> 

A readme file lists the SPI for SAP transport file names; you can find the readme file on 
the HPOM management server in the following location: 

%OvShareDir%\Packages\SAPTransports 

7	 Highlight the desired transport. 

If you do not select any transport, SAP assumes you want to select all transports in 
the list. 

8	 Select Request > Import. The Import Request dialog box opens. 

9 Select the Check [✓] icon or use the Enter key to add transaction requests. 

10 Enter the target client number (000 is the default client number). 

You must import the SPI for SAP user role into the client where you created the 
SAP user "ITOUSER". For more information, see Setting Up an SAP User for 
HPOM on page 32. The default client for the SPI for SAP user-role transport is 099. 

11	 Check items in the Option tab that are appropriate for your system. 

12	 Click the Check [✓] icon or press Enter. 

Setting Up an SAP User for HPOM 

You need to provide HPOM with an SAP log on so that SPI for SAP tools, monitors, or actions 
have access to SAP. For each SID where you want to allow automated logon of HPOM users, 
perform the following actions: 

1 Log on to SAP. 

2 Call the transaction: SU01. 
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3 Create a new user named ITOUSER, using the parameters specified in the following 
table. 

User roles:	 SAP User Roles need to be defined from SAP version 4.6C 

onwards. Use transaction SU01, as shown in Figure 3. 

Note that ITOUSER requires authorizations to be able to 

execute SPI for SAP ABAP functions. Select the following 

user roles:

• /HPOV/SAPSPI_MONITORING_TCODE 

Enables the use of certain SAP transactions and does 
not place any restrictions on the SPI for SAP 
functionality. 

• /HPOV/SAPSPI_MONITORING_NO_TCD 

The role does not contain any SAP transaction 
authorizations (NO_TCD) and restricts the SPI for 
SAP functionality by preventing the SAP user from 
starting SPI for SAP applications or 
operator-initiated actions. The SAP user can, 
however, still logon to SAP. 

• /HPOV/SAPSPI_SECURITY_MON 

If you plan to use the r3monsec monitor to monitor 
SAP System security, you must also assign to 
ITOUSER (or the user under which r3monsec runs) 
the authorizations defined in /HPOV/ 
SAPSPI_SECURITY_MON, the SPI for SAP security 
user role. 

User type:	 DIALOG - If you do not set the user type to DIALOG and 

do not define a corresponding password, the SAP GUI will

not work and many of the operator-initiated actions and 

applications within HPOM will not be available. However,

performance and event monitoring do work with the

CPIC/SYSTEM user.


Initial 	 Any SAP-admissible value except HPSAP_30 - The 
password:	 password HPSAP_30 is associated with the use of the


=default value in the SPI for SAP’s central configuration 

file r3itosap.cfg. If you intend to use the =default

value, you cannot enter HPSAP_30 now as you will need it 

when you first log in to SAP (as ITOUSER) after 

completing setup, and SAP prompts you to set 

ITOUSER’s password.


Since user-role transports are client-dependent, you must create the SAP user ITOUSER in 
the same SAP client as the import client of the SPI for SAP user-role transport. If you do 
not, it is not possible to assign user role /HPOV/SAPSPI_MONITORING* to the newly created 
ITOUSER. 

4 Activate the profile and assign it to the SAP user ITOUSER, which you have already 
created. 
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While assigning SPI for SAP roles, it is important to verify that all required authorization 
objects are active and the user comparison completes successfully. SAP uses the color 
green to indicate that user authorization objects are active or that user comparisons 
complete successfully; the color red indicates that you need to activate user authorization 
objects or complete a user comparison. 

5 Log on to SAP as the user ITOUSER. 

6 SAP prompts you to change the password, which you initially defined for ITOUSER. If you 
do not need to define your own SAP user logins and intend to make use of the =default 
value in the SPI for SAP’s central monitor-configuration file r3itosap.cfg, enter the 
following new password: HPSAP_30. 

Figure 3 SAP User Roles for ITOUSER 

Setting Up Configuration Values for the SPI for SAP Monitors 

To conclude the SAP-specific tasks, you have to set up initial configuration values in 
monitor-specific configuration files for each of the Smart Plug-in for SAP monitors before you 
deploy the configuration files to the managed nodes. The Smart Plug-in for SAP includes the 
monitors listed in Table 6 below. 

Table 6 Smart Plug-in for SAP Monitors 

Monitor Name 

r3monaco 

r3monale 

r3monal 

r3monchg 

r3moncts 

Description 

Alert collector for TemSe calls 

ALE monitor 

CCMS monitor 

System change monitor 

Correction and Transport system monitor 
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Table 6 Smart Plug-in for SAP Monitors (cont’d) 

Monitor Name 

r3mondev 

r3mondmp 

r3mondisp 

r3monjob 

r3monlck 

r3monoms a 

r3monpro 

r3monrfc 

r3monsec 

r3monspl 

r3montra 

r3monupd 

r3monusr 

r3monwpa 

r3status 

Description 

Trace monitor of the SAP logfile: 
<SID>/<INSTANCE>/work/dev* 

ABAP/4 Dump monitor 

ABAP/4 Dispatcher monitor 

Job monitor 

Lock check monitor 

Operation mode switch monitor 

Operating system process monitor 

SAP RFC destination monitor 

Security monitor 

Spool monitor 

Transport monitor 

Update monitor 

User monitor 

Work-process availability monitor 

SAP status monitor 

a.	 Due to changes in SAP, the operation-mode monitor r3monoms is not 
supported with SAP Netweaver 04/WebAS 07. 

The Smart Plug-in for SAP also includes two sets of configuration and distribution tools as 
follows: 

Global tools which apply to all managed nodes


Local tools which apply only to a specified managed node


For more information about (and instructions for) configuring monitors see the SPI for SAP 
Online Help. 

Modifying Configuration-File Policies 

In this step, you use the configuration-file policy editor and the default policy templates to 
create your own global configuration-file policies for each of the SPI for SAP monitors, which 
run on the SAP servers you want to monitor with the SPI for SAP. HPOM keeps track of the 
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changes you make by saving the modified policy with an numeric suffix that increments with 
each new version of the policy; if the default policy version number is 11.0, the new version 
you save will be 11.10. 

The SPI for SAP provides a default configuration-file policy for each configuration file. 
Although you can use the default configuration for initial deployment, you will need to modify 
the configuration to suit the needs of your SAP environment. 

To modify a configuration-file policy for the SPI for SAP monitors, follow these steps: 

1 In the HPOM console, browse to the following directory: 

Policy Management > Policy Group > Agent policies grouped by type 

2	 In the details pane, double click the configuration-file policy corresponding to the SPI for 
SAP monitor that you want to modify, for example: r3mondmp. The configuration-file 
policy for r3mondmp, the ABAP Dump monitor, appears in the configuration-file policy 
editor. 

The filename r3mondmp.cfg is used here only as an example. If you want to 
modify the default configuration files, edit the global configuration file which 
corresponds to each of the Smart Plug-in for SAP monitors you want to deploy to 
(and run on) the SAP managed nodes. 

3	 Scroll down through the configuration-file policy and make the appropriate modifications 
for your environment. 

4	 Click Save to confirm the changes to your configuration-file policy and exit the editor. The 
new version of the configuration-file policy for the SPI for SAP monitor appears in the list 
of policies in the details pane. 

If you use HPOM tools to edit a configuration file which uses the r3moncol 
structure, the SPI for SAP automatically validates the contents of the file when 
you attempt to save it and will not allow you to save a file that contains a 
configuration error. For more information about the validation tool and the error 
messages it generates, see the SPI for SAP Online Help. 

If the SPI for SAP finds an error in the modified configuration file, it displays a message 
indicating what the problem is. For example, if you misspell the keyword TraceLevel 
when attempting to set the trace level (info, all, debug) in a monitor configuration file, you 
see the following (or similar) message when trying to save the modified file: "TraceLeevel 
is an unknown keyword", as illustrated in Figure 4 on page 37. You will have to locate 
and fix the problem before trying to save the file again. When the SPI for SAP is sure that 
the modified file is valid, it saves the file and increments the file version number, too. 

5	 Deploy the newly created configuration-file policies to the SAP managed nodes as 
described in Deploying SPI for SAP Policies to Managed Nodes on page 43. 
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Figure 4 Configuration-File Parsing Error 
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4 Configuring HPOM Administration Tasks

In this phase of the SPI for SAP configuration, you use the HPOM console to integrate the SPI 
for SAP with HPOM and bring all the SAP servers that you want to monitor under HPOM 
management. 

The tasks in this section assume that the SAP systems you want to monitor with the 
SPI for SAP are already HPOM managed nodes. If this is not the case, see the HPOM 
on-line help for instructions that explain how to add managed nodes to HPOM. 

Specifying SAP Systems to Monitor 

This section describes how to use the configuration-file policy editor to define which SAP 
Systems you want to monitor with the SPI for SAP. You must use the r3itosap.cfg
configuration file to define the SAP Systems to monitor with the SPI for SAP. 

To specify the SAP systems to monitor, follow these steps: 

1	 In the HPOM console, browse to the following directory: 

Policy management > Policy groups > SPI for SAP 

You must set up SAP users for each SAP client so that the users have permission 
to display and maintain CCMS. The list of SAP clients you made in Before You 
Begin on page 16 includes the information you need for each configuration line. 
For more information about how to set up SAP users for HPOM, see Setting Up an 
SAP User for HPOM on page 32. 

2	 In the HPOM console, locate and double-click the global_r3itosap policy template. The 
configuration-file policy editor displays the selected file as illustrated in Figure 5 on 
page 40. 

3	 Using the format of the examples in the r3itosap.cfg configuration file, add a 
HostSapAssign entry for each SAP instance, which you want to monitor with the SPI for 
SAP. When adding entries to r3itosap.cfg, bear in mind the following important 
points: 

•	 The language specified in each HostSapAssign entry determines the language the 
SPI for SAP monitors use when logging in to SAP and must be one of the languages 
currently supported by the SPI for SAP transports, for example: =EN (English) or =JA 
(Japanese). The language you specify here does not affect or determine the language 
used when starting the SAP GUI. 

•	 r3status, the tool the SPI for SAP uses to monitor the status of SAP Systems, does 
not attempt to verify or validate the existence of the SAP Systems specified in 
r3itosap.cfg. If r3status cannot find a named SID, for example: because of a 
spelling mistake, it reports the SID as unavailable. 
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•	 In the central, SPI for SAP, monitor-configuration file r3itosap.cfg, the string 
=default is associated with the default ITOUSER password “HPSAP_30”. If you 
intend to make use of your own SAP user logins, you need to replace =default with 
the appropriate user password. As long as you use the HPOM policy editor to edit the 
r3itosap.cfg file, the password is encrypted automatically when you save the file. 
By default, the SPI for SAP resolves the name of the managed nodes that generate 
messages as the host name defined in the SAP variable, SAPLOCALHOST. 

Figure 5 Editing the r3itosap.cfg File 

4	 If the hosts you add to the r3itosap.cfg file are configured in a high-availability cluster, 
you need to add an extra entry to the host-mapping section of the r3itosap.cfg file: the 
information in the host-mapping section maps the names of the physical nodes in the 
high-availability cluster to the name of the node defined in the SAP variable, 
SAPLOCALHOST and, in addition, to the host name you want to associate with any 
messages from the cluster when they appear in the HPOM console or the Service Map. 

The host names specified in the r3itosap.cfg file must be known to HPOM and be 
resolvable. Whether you choose to use long or short host names depends on how you have 
set up name resolution in your network. 

The cluster host-names appear in the HostMapping entry in the form of a 
comma-separated list. The last item in the HostMapping entry defines the name of the 
host with which you want to associate any messages that are generated by nodes in the 
high-availability cluster. For example: 
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=ClusterHostA,ClusterHostB,SAPLOCALHOST =<HPOM_Msg_Node> 

Short host names are not allowed in the host-mapping section of the 
r3itosap.cfg file. Make sure you use fully qualified host names for all the host 
names you specify in the host-mapping section of the r3itosap.cfg file. 

The example below shows the entry you would add to the host-mapping section of the 
r3itosap.cfg file if you want to use the SPI for SAP to monitor a high-availability 
cluster in which the names of the two physical nodes are True and False, the SAP 
variable SAPLOCALHOST is defined as maybe, and the name of the host with which to 
associate messages from the cluster is example. 

Example: Mapping SAP hosts in a cluster 

# cluster host mapping

HostMapping =EP7 =78 =true.com,false.com,maybe.com =example.com


In a high-availability cluster, the name of the host with which you associate HPOM 
messages (<HPOM_Msg_Node> in the example above) is usually (but does not have to be) 
the same as the host defined in SAPLOCALHOST. Whether SAPLOCALHOST is (or is not) the 
same as <HPOM_Msg_Node> has an impact on what you need to include in the 
host-mapping section, as follows: 

• If SAPLOCALHOST and <HPOM_Msg_Node> are the same host: 

No entry for SAPLOCALHOST is required in the list of physical cluster nodes, for 

example:


=ClusterHostA,ClusterHostB =<HPOM_Msg_Node>


• If SAPLOCALHOST and <HPOM_Msg_Node> are not the same host: 

You need to add an entry for SAPLOCALHOST at the end of the list of physical cluster 

nodes, for example;


=ClusterHostA,ClusterHostB,SAPLOCALHOST =<HPOM_Msg_Node>


All physical nodes in the high-availability cluster must appear in the HPOM 
console. You also need to add to the HPOM console as node type Other (Message 
only) the host which you define in <HPOM_Msg_Node> in the example above. For 
more information about setting up the SPI for SAP in a high-availability 
environment, see Configuring the SPI for SAP in a Cluster Environment on 
page 66. 

To ensure that automatic or operator-initiated actions are always able to open an SAP 
GUI on the node where the SAP instance is running in the high-availability cluster, you 
need to add a HostSapAssign entry to the r3itosap.cfg file, which specifies the 
cluster-host name defined in the variable <HPOM_Msg_Node>. 

See also Host Mapping on Cluster Nodes on page 67 for information about how to avoid 
problems with HP Operations agent settings for host names and IP addresses overriding 
settings defined in the host-mapping section of the SPI for SAP’s central configuration 
file, r3itosap.cfg, which could cause the wrong host name to appear in messages 
originating from the cluster. 

5 Save your changes and exit the policy editor. When saving the policy, we recommend you 
use the configuration-file policy-type naming conventions, for example: 
global_r3itosap. 

6 Deploy the r3itosap.cfg policy to the managed nodes you want to monitor with the SPI 
for SAP. Right-click the r3itosap.cfg policy you modified and use the following menu 
option: 
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All Tasks > Deploy on... 

The information in the r3itosap.cfg policy is used by the service auto-discovery policy, 
r3sdisc, to generate a service view of your SAP landscape. If you intend to use the 
service-views feature, make sure that you deploy the r3itosap.cfg policy to the managed 
node(s) for which you want to generate service views before you run the service 
auto-discovery. 
The Host mapping entry in the r3itosap.cfg file should have the host name details as: 
HostMapping <SID> =<NR> =<system_name>.true.hp.com =<system_name>.hp.com 

where,

SID - system ID for the server

NR - the NR number of the server


For more information about running service discovery and setting up service views, see the 
HP Operations Smart Plug-in for SAP Online Help. 

Configuring the SPI for SAP Monitors 

The SPI for SAP monitors that you deploy to the SAP servers that are managed by HPOM 
require information about what to monitor and how. The monitors obtain this information 
from default configuration files, which are installed by the SPI for SAP. Each of the SPI for 
SAP monitors has its own default configuration file. 

In this step, you use the configuration-file policy editor to edit global configuration files (from 
the default files) for each of the SPI for SAP monitors which runs on the SAP servers. After 
you have edited the configuration files, you deploy them to the SAP servers using the 
standard HPOM policy-deployment mechanism. 

To modify an existing configuration-file policy for the SPI for SAP monitors, follow these 
steps: 

1	 In the HPOM console tree, browse to the following directory: 

Policy Management > Policy Groups > SPI for SAP 

2	 In the details pane, locate and double-click the configuration file associated with the 
monitor you want to configure, for example; the global_r3mondmp file. The 
configuration-file policy editor displays the selected file as illustrated in Figure 5 on 
page 40. 

The r3itosap.cfg file shown in Figure 5 on page 40 is not associated with any 
one, particular monitor; it is the SPI for SAP’s central configuration file, which all 
the other monitors use to login to the SAP Systems you want to manage. This is 
the only global configuration file that must be edited. 

3 Although all other global configuration files can be used in their default state, they 
generate a large number of messages, some of which you might not at first need. If you 
want to modify a configuration file, for example to ensure you only receive the messages 
you do need, scroll down to the end of the Configuration File content box, where you will 
find the alert definitions and can make any changes as required. For more information 
about the contents and syntax of the SPI for SAP monitors, see the SPI for SAP Online 
Help. 
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4 Save your policy and exit the configuration-file policy editor. The modified 
configuration-file policy for the SPI for SAP r3mondmp monitor appears in the list of 
policies in the details pane. 

If you use HPOM tools to edit a configuration file which uses the r3moncol 
structure, the SPI for SAP automatically validates the contents of the file when 
you attempt to save it and will not allow you to save a file that contains a 
configuration error. For more information about the validation tool and the error 
messages it generates, see the HP Operations Smart Plug-ins SPI for SAP Online 
Help. 

5 Deploy the modified configuration-file policies to the SAP managed nodes. 

Deploying SPI for SAP Policies to Managed Nodes 

The SPI for SAP policies are organized into default groups, all of which are part of the policy 
group SPI for SAP. The SPI for SAP policy groups are: 

• SAP R3 6.xCI 

• SAP R3 6.x/7.0AS/7.1kernel 

• SAP R3 7.0CI/7.1kernel 

• SAP NW Java Monitoring 7.0 

• SAP NW Java Monitoring 7.1 

You can assign only one policy group to a managed node. Which policy group you assign is 
determined by the software and software version running on the managed node and whether 
the node is a central instance or an application server. 

Remember to deploy an alert monitor’s configuration-file policy before deploying the 
corresponding alert monitor itself. The alert monitors read these configuration files on 
startup. For example, you need to deploy the r3moncts configuration-file policy before you 
deploy the corresponding alert monitor, r3moncts. For more information, see Configuring the 
SPI for SAP Monitors on page 42. 

The SPI for SAP default policy groups contain all the SAP monitors supplied with the Smart 
Plug-in for SAP. Deploying a policy group automatically activates the monitors, which the 
group contains. In addition, since all SPI for SAP policies belong to the Category “SPI for SAP 
Instrumentation”, when you deploy a SPI for SAP policy or policy group, the 
policy-deployment operation triggers the deployment of the required SPI for SAP 
instrumentation. The SPI for SAP instrumentation package contains the actions, commands, 
and monitors, which the SPI for SAP requires to ensure features and functionality work as 
expected. 

To Avoid Receiving Unnecessary or Unwanted Messages, follow these steps: 

1 Make copies of the default policy groups and modify the copies to create your own policy 
groups containing only those monitors and policies you need. 

2 Tune the policies and monitors to suit the requirements of your environment before 
deploying them to the nodes you want to manage with the Smart Plug-in for SAP. This 
will help prevent additional unwanted messages. 
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Create Policy Groups 

As HPOM administrator, make your own policy group as illustrated in Figure 6 on page 45. 
You should then remove those policies and monitors you do not need from the new policy 
group, as follows: 

1 Expand the Policy Groups item and select and expand SPI for SAP to display all the 
default policy groups for the Smart Plug-in for SAP. 

2 Create a new policy group by selecting and right-clicking SPI for SAP and selecting the 
following menu: 

New > Policy Group 

3	 Enter a name for the new policy group in the fields provided, and then click OK. 

4	 In the left pane, select the existing policy group from which you want to copy policies and, 
in the details pane, drag the policies you want to place in the new policy group over and 
drop them on to the policy group you have just created. 

Deploy Policy Groups 

The policies and policy groups you deploy depends on which SAP version is installed on the 
managed nodes and whether the nodes host a central instance or an application server. 

1	 In the console tree, select and right click the new policy group or groups you have created 
(containing the monitors you need) and use the following menu option: 

All Tasks > Deploy on... 

2	 Use the Deploy Policies on... window to select the managed nodes to which you want to 
deploy the new policy group. 

3	 Click OK to finish deploying policies. 

You can use this opportunity to deploy any other policies not present in the SAP 
-specific policy groups. 

4	 To check that the policies deployed successfully, right click a managed node and selecting 
the following menu option from the drop-down menu that appears: 

View > Policy Inventory 

Some of the monitors may require SAP configuration. See Configuring HPOM 
Administration Tasks on page 39 for additional information on SAP-Specific tasks. 
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Figure 6 Removing Policies from a Policy Group 

You can configure the HP Operations agent to use a non-privileged user on Windows nodes. 
For more information, refer to Using a Non-Privileged Windows User with the SPI for SAP on 
page 119. 
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5 Using SPI for SAP Tools 

The Tool Bank window displays the tools which you can use to manage your SAP NetWeaver 
environment. You can do the following: 

• Start tools 

• Broadcast commands on selected nodes 

SPI for SAP Tool Groups 

The Tool Bank window represents a group of tools. You can click a group to open a 
second-level desktop containing the tools of the group. The following tool groups are added to 
the Tool Bank under the SPI for SAP group when the SPI for SAP is installed: 

• SAP R/3 Admin 

• SAP R/3 NT 

• SAP R/3 UN*X 

The SAP R/3 Admin Tool Group 

The SAP R/3 Admin tool group includes tools for editing and distributing files for global 
configuration, as well as other administrative functions such as moving the SAP transport to 
the SAP transport directories on managed nodes. 

The following table lists the tools which appear in the SAP R/3 Admin tool group and 
describes briefly what each of the tools does. 
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Table 1 SAP R/3 Admin Tools 

Tools 

Check the SAP 

NetWeaver 

Connection


Create SPI SAP Helps you configure the monitoring environment for the SAP 
NetWeaver Config NetWeaver Web Application Server (J2EE) 

Install Performance Installs Performance package on the UNIX nodes 
Package (UNIX) 

Install Performance

Package (Windows)


Install the RFC

Library


Remove Performance

Package (UNIX)


Remove Performance

Package (Windows)


Write Statistical 

Records


Description 

Checks if a successful connection was established between the SPI 
for SAP and the SAP NetWeaver Web Application Server 

Installs performance package on the Windows nodes 

Installs the downloaded RFC libraries into appropriate directories 
on the management server 

Removes performance package on the UNIX nodes 

Removes performance package on the Windows nodes 

Write statistical records in SAP 

For more information about editing and distributing monitor configurations, see the HP 
Operations for Windows Smart Plug-in for SAP Administrator’s Online Help. 

The SAP R/3 UN*X and SAP R/3 NT Tool Groups 

These two groups include tools that provide direct, context-sensitive startup of the SAP 
front-end on UNIX and Microsoft Windows platforms respectively. For instance, if you receive 
a performance alert, you can click the Performance icon and open the SAP performance 
analysis tool. 

In addition, the SAP R/3 UN*X group includes a number of tools that involve interactive 
actions with terminal output, for example: Check R/3 Database, Status R/3 Config, or 
Version Verify. These tools are not supported on the Microsoft Windows platform. 

Before you select a tool from one of these groups, you must select the managed node on which 
you want the tool to run. Make sure that you select the tool from the tool group that 
corresponds to the managed node’s platform, for example: UNIX or Microsoft Windows. 

The following table lists the tools which appear in the SAP R/3 UN*X and SAP R/3 NT Tool 
group and describes briefly what each of the tools does. 
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Table 2 SPI for SAP Tools that Call SAP Transactions 

Tool Description 
SAP Trans- 
action code 

Control Panel CCMS control panel RZ03 

DB Performance Shows database performance through 
tables and indexes. 

DB02 

Gateway Gateway monitor SMGW 

Job Maintain Define background jobs SM36 

Job Overview Status of background jobs SMX 

Job Performance Job performance SM39 

Maintain 
Thresholds 

Maintenance thresholds RZ06 

Operation Modes Maintain operation modes RZ04 

Operation Sets Maintain operation sets SM63 

Performance Workload analysis ST03 

Process Process overview SM50 

Profile 
Maintain 

Profile maintain RZ10 

Servers Server overview SM51 

Syslog System log, local analysis SM21 

Users User overview AL08 
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Launching Tools 

To launch a tool, follow these steps: 

1 At the HPOM console, select Tools → SPI for SAP → <Tools>. 

2 In the details pane, right-click on the tool you want to launch and select All Tasks → 
Launch Tool. The Select where to launch this tool dialog box opens. 

3 In the dialog box, select the check box next to every node you want to configure and click 
the Launch... button. 
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6 Using and Customizing the SPI for SAP Policies

The SPI for SAP policies help you monitor the SAP Application servers. You can customize 
these policies depending on the requirements of your IT environment. This chapter includes 
general guidelines about the SPI for SAP policies and explains how you can customize them. 
For more information see the Policies section in the HP Operations for Windows Smart 
Plug-in for SAP Administrator’s Online Help. 

SPI for SAP Policy Group and Types 

You can customize the SPI for SAP policies to suit the needs of your IT environment. However, 
you can use these policies without any modifications. 

SPI for SAP Policy Groups 

The SPI for SAP policies are organized under the SPI for SAP policy group. 

The SPI for SAP contains the following policy groups: 
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SAP NW Java Monitoring 7.0 - This group monitors the health of the J2EE engine of the 
SAP NetWeaver Web Application Server. With the help of a series of policies, you can collect 
metrics indicating the health, availability, and performance of the J2EE engine of an SAP 
NetWeaver Web Application Server. 

SAP NW Java Monitoring 7.1 - This group monitors the health of the J2EE engine of the 
SAP NetWeaver Web Application Server. With the help of a series of policies, you can collect 
metrics indicating the health, availability, and performance of the J2EE engine of an SAP 
NetWeaver Web Application Server. 

SAP R3 6.x/7.0AS/7.1kernel - This group contains the policies for monitoring the 
availability and health of the Web Application server ABAP on the application server of the 
SAP versions 6.40, 7.0, and 7.1. This includes metrics related to trace files, dispatcher, and 
work processes. 

SAP R3 6.xCI - This group contains the policies for monitoring the health and availability of 
the Web Application server ABAP for the Central instance of the SAP version 6.40. It includes 
metrics related to Idocs, CTS, ABAP dumps, locks, jobs, rfc destinations, spool, security, 
update, users, work processes. 

SAP R3 7.0CI/7.1kernel - This group contains the policies for monitoring the health and 
availability of the Web Application server ABAP for the central instance of the SAP versions 
7.0 and 7.1. It includes metrics related to Idocs, CTS, ABAP dumps, locks, jobs, rfc 
destinations, spool, security, update, users, and work processes. 

SPI for SAP Policy Types 

The SPI for SAP policies are of two types: 

• Measurement Threshold policies pertain only to individual metrics 

• Scheduled Task policies pertain to all metrics collected in a specific interval 

Measurement Threshold and Scheduled Task Policies 

Measurement threshold policies define how the collected data is interpreted for the individual 
metric. The rules it contains pertain to threshold values and actions that occur when those 
values are met or exceeded. In general an exceeded threshold generates alerts/messages in 
the HPOM message browser. In HPOM, you can change the threshold within a measurement 
threshold policy by double-clicking the policy and selecting the Threshold levels tabbed 
page. 

Scheduled Task policies define what metrics are collected in the specified collection interval. 
You can see how this works by double-clicking a Scheduled Task policy. On the policy’s Task 
tabbed page a list of targeted metrics appear in the Command text box. 
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Incoming values for metric SPISAP_0231 are compared against its threshold limits. In the 
following illustration, the threshold limit is set to 500. 

Monitor policies define all metrics for the SPI for SAP application that are scheduled for 
collection at specified interval. Within the name of each monitor policy is its collection interval 
(for example, SPISAP-71-High_1h, where collection interval is one hour). When you open any 
monitor policy, you can see all metrics listed as number and collected within the interval 
following the -m option. 

Basic Policy Customizations 

This section covers basic policy customizations like changing threshold values, scheduling or 
deleting a metric from data collection, opening a metric policy or collector policy, and so on. 

Before you begin to customize any of the policies, you must make copies of the original policies 
so that the default policies remain intact. 

Modifying Metric Policies 

You can modify the metric attributes for all monitored instances of SPI for SAP. 
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Threshold Level and Actions 

To modify the threshold level and actions, follow these steps: 

1 From the HPOM console, select Operations Manager → Policy management → Policy groups 
→ SPI for SAP. 

2 Select the appropriate policies. 

3 Double-click the policy for which you want to change the threshold value. The policy 
window opens. 

4 Select the Threshold levels tab. 

5 From the Level summary pane, click Threshold level. The Threshold Level window opens. 

You can modify the metric attributes from this window.


In the above figure, the threshold limit is set to 1e+006. An alert message is raised with the 

severity when the threshold limit exceeds 1e+006.


The following metric attributes can be modified:


•	 Threshold limit: The value that triggers a message if it is met or crossed. 

•	 Short-term peaks: A minimum time period over which the monitored value must exceed 
the threshold before generating a message. For a message to be sent, the value must be 
greater than the threshold each time the value is measured during a duration that you 
select. If the duration is set to 0 or the box is left empty, an alarm is generated as soon as 
HPOM detects that the threshold has been equaled or crossed. 

•	 Reset: A limit below which the monitored value must drop (or exceed, for minimum 
thresholds) to return the status of the monitored object to normal. 
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As the following illustration shows, the Threshold Level window has three action tabs. You 
can click any of the action tabs to set the related action. 

•	 Start actions: Actions carried out the first time that the threshold is crossed. 

•	 Continue actions: Actions carried out at each subsequent polling interval if the reset 
value is not reached. 

• End actions: Actions carried out after the threshold crosses the reset value.


In each of the actions tabs, you can set the type of actions to perform.


The SPI for SAP lets you generate Performance Manager graphs or Reports, or to add custom 

programs. You can generate the reports and graphs through:


•	 Automatic command. A command run when the rule is matched. The automatic 
command delivered with the SPI for SAP generates a snapshot annotations report that 
shows the data values at the time the action was triggered from an exceeded threshold. 
You can view the report in the message annotations. 

•	 Operator-initiated command. A command attached to the message that the rule sends 
to the message browser. You can run this command from the message browser. The 
operator-initiated command delivered with the SPI for SAP lets you click the Perform 
Action button to view a graph of the metric whose exceeded threshold generated the 
message, along with other related metric values. 

Message Severity 

To modify the message and severity of a policy, follow these steps: 

1 From the HPOM console, select Operations Manager → Policy management → Policy groups 
→ SPI for SAP → en. 

2 Double-click the policy you want to modify the severity and message text. The 
Measurement Threshold window opens. 

3 From the Level summary pane, click Threshold level. The Threshold Level window opens. 
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4 Click the Start Actions tab and click Message... The Outgoing Message window opens. 

You can modify the following attributes:


Severity: Indicates the importance of the event that triggers this message.


Message Text: You can modify the text of the message but do not modify any of the 

parameters—beginning with $and surrounded by <> brackets—in a message. 

5 Click OK to save the changes. 
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Advanced Policy Customization 

Advanced policy customizations include making copies of default policy groups to customize a 
few settings and deleting whole groups of metrics within a policy’s command line. 

Creating New Policy Groups 

You can separate the custom policies that you create from the original default policies by 
creating new policy groups. Before you create a new policy group you must first determine the 
metrics and policies you want to modify. To create a new policy group, follow these steps: 

1 Create a new policy group: 

a	 In the HPOM console, select Operations Manager → Policy management → Policy groups 
→ SPI for SAP. 

b Right-click the policy group you want to copy and select Copy. For example, right-click 
the Metrics policy group under SAP NW Java Monitoring 7.0 and select Copy. 

c Right-click the group under which this policy group is located and click Paste. For 
example, right-click SAP NW Java Monitoring 7.0 and click Paste. 

d Right-click the new group name and select Rename. 

2 Right-click the original policies within the new policy group: 

a Double-click the new policy group to get the list of policies. 

b Double-click a policy. The policy window opens. 

c	 Click File → Save As. The Save As window opens. 

d	 Enter a new policy name and click OK. 

e	 Click File → Exit to close the policy window. 

3	 Delete all the policies within the new policy group. To do this, select the policies and delete 
it. 

Viewing Text-Based Reports 

Some policies have actions defined with threshold violations or error conditions. These actions 
automatically generate reports. The reports are snapshots of data values collected from the 
server around the time that the alarm occurred. 

The reports discussed in this section are different from HP Reporter reports that show 
consolidated data generated as web pages in a management-ready presentation format. See 
Integrating the SPI for SAP with Reporter on page 75 

Automatic Command Reports 

Many metrics generate Automatic Command Reports. These reports are generated as soon as 
an alarm is triggered in HPOM. Automatic Command reports are generated for a single SPI 
for SAP instance with the exceeded threshold. 
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When an Automatic Command report is executed from HPOM, the server is queried for 
additional data. If you set the HPOM console message browser to display the SUIAON 
column, you can see an “S” under the “A” column (see the following figure), which indicates 
that a generated report is available in the Annotations area of the Message Properties. 

To view Automatic Command reports, do one of the following: 

•	 Double-click a message in the HPOM message browser. The Message Properties window 
opens. Select the Annotations tab. 

•	 Right-click a message and select Annotations. The Message Properties window opens. 

The reports are available in the Message Properties window. These reports show data values 
of a single server. Column descriptions in the window provide further information. 

Manually Generated Reports 

Reports are generated for all SPI for SAP instances configured on the managed node. In 
contrast to Automatic Command reports that are generated for a single SPI for SAP instance, 
manually generated reports reflect the current state of all SPI for SAP instances on the 
managed node. 

To generate a report manually, follow these steps: 

1	 From the HPOM console, select Operations Manager → Tools → SPI for SAP → en. 

2 Double-click the report you want to see. The Select Where to Launch This Tool window 
opens. 

3 Select the managed node for which you want to see reports and click Launch. The Tool 
Status window opens. 

4 View the report in the tool output field. 

5 Click Close to close the field. 
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7 The SPI for SAP in a High-Availability 
Environment 
The information in this section helps you to understand the process of installing and 
configuring the SPI for SAP in a high-availability environment such as MC/ServiceGuard or 
Microsoft cluster. Although the information provided in this section concentrates on example 
configurations, the basic concepts are the same for any high-availability environment as far as 
the SPI for SAP is concerned. 

The information in this section explains how to set up the SPI for SAP to manage SAP 
on managed nodes, which are configured in a high-availability environment. If you 
want to set up the HPOM management server in a high-availability environment, see 
the HPOM documentation. 

Cluster Configurations 

The most typical implementations of high-availability software in SAP landscapes involve 
configuring the central-instance server and the database server in a cluster and installing 
either one combined high-availability package on the central-instance server, or alternatively, 
two separate high-availability packages on the central-instance server and the database 
server, respectively. Typically, application servers are not configured as part of the 
high-availability cluster. The two configurations which we describe in more detail in this 
section are as follows: 

• single-package configuration 

In the single-package configuration, the SAP database and central instance are located on 
the same server and included in the same high-availability package. The combined 
package can be switched temporarily to the secondary node in the event of problems. 

• twin-package configuration 

In the twin-package configuration, the SAP database and central instance are located on 
different servers. Either package can be switched temporarily to the alternative node in 
the event of a problem on the primary (physical host 1) or secondary (physical host 2 or 
backup) node. 

The Single-Package Configuration 

In the single package concept, the server where the database and central instance normally 
run is included in a cluster with another server, which will act as the secondary node in the 
event of a package switch. The secondary node can perform any one of the following roles: 

• SAP application server 

• SAP test or development system 

• Stand-by 
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In Figure 1 on page 60, the application servers, which are not included in the cluster, 
reference the cluster package (❸) by means of its re-locatable IP address, not by reference to 
the fixed IP address of the node on which the cluster package is running. If a problem occurs, 
the central instance and database are taken down on the primary or physical host 1 node 
(cluster node ❶), and then brought up again on the secondary or physical host 2 node (cluster 
node ❷). At the same time, the shared disks are deactivated on the primary node and 
reactivated on the secondary node. 

Figure 1 The Single-Package Configuration 

After the cluster software completes these actions, the application servers can reconnect to 
the central instance and database (❸ in Figure 1 on page 60) using the same relocatable IP 
address, which, as the name suggests, moves with the package. 

The Twin-Package Configuration 

In the twin-package configuration, the central instance and the database are installed on 
different servers, which for the sake of convenience we can call cluster nodes ❶ and ❷ 
respectively, as illustrated in Figure 2 on page 61. The central-instance server and the 
database server form a high-availability cluster, where each server can act as the secondary 
node for the other in the event of a package switch. 
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Figure 2 The Twin-Package Configuration before a Package Switch 

The application servers are not included in the cluster and, as illustrated in Figure 2 on 
page 61, reference each package by means of each package’s own relocatable IP address—not 
the fixed IP addresses of cluster-nodes ❶ and ❷. 

If a problem is identified on the central-instance server, the central instance (❸) is taken down 
on cluster node (❶), and then brought up again on the cluster node (❷). At the same time, the 
central instance shared disk is deactivated on the host node and reactivated on the secondary 
node. 

Figure 3 on page 62 shows the situation after the switch of the SAP central- instance package 
(❸). As soon as the central-instance package is up and running on the cluster node (❷), the 
application servers can reconnect to the central instance using the same IP address as before 
the failover, namely; the central-instance package’s relocatable IP address, which moves along 
with the package at the time the failover occurs. 
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Figure 3 The Twin-Package Configuration after a Package Switch 

Pre-requisites 

The information in this section is designed to help you install and configure the SPI for SAP 
in a high-availability environment: it is not intended to explain either how to set up the 
high-availability software or HPOM. Before you start the process of installing the SPI for SAP 
in a high-availability environment, please read through and consider the information 
included in the following sections: 

• Software Requirements on page 62 

• Configuration Requirements on page 63 

• Service Reports and Performance Graphs on page 63 

• Service Views on page 63 

Software Requirements 

The cluster software must already be correctly installed and configured in your SAP 
landscape, and the cluster should function correctly. For example, you have to decide whether 
to configure one package for the central instance and the Database Server or set up separate 
packages for each part. These decisions become important later in the configuration process. 
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Configuration Requirements 

The SAP servers in the high-availability cluster must already be configured as HPOM 
managed nodes with the appropriate HPOM agent software and functionality installed and 
running. 

All physical nodes in the high-availability cluster must be added to the HPOM console. 
You also need to add to the HPOM console as node type "Other" (Message only) the 
host name which you define as the HPOM message host name in the host-mapping 
section of the r3itosap.cfg file. For more information, see Specifying SAP Systems 
to Monitor on page 39. 

Service Reports and Performance Graphs 

If you want to generate SPI for SAP service reports and performance graphs for all the nodes 
in the high-availability cluster, make sure that the following conditions are true: 

•	 The appropriate performance-agent functionality (HP Software Embedded Performance 
Component or the HP Performance Agent) must be installed, configured, and available on 
all the nodes in the cluster. 

•	 The appropriate SPI for SAP R/3 Performance Agent functionality must be installed, 
configured, and available on all the physical nodes in the high-availability cluster. For 
more information about installing and configuring the SPI for SAP R/3 Performance 
Agent, see the HP Operations for Windows Smart Plug-in for SAP Administrator’s Online 
Help. 

•	 Both HP Performance Manager and HP Reporter must be installed, correctly configured, 
and available on a machine that can see the nodes in the high-availability cluster. Note 
that these services are not usually (and do not need to be) part of the cluster itself. 

Service Views 

You can use tools provided by the SPI for SAP to generate Service Views automatically. If you 
want to make use of Service Views with the SPI for SAP, you need to set it up to see the 
services you want the SPI for SAP monitor in the SAP environment. 

The service-discovery process uses information stored in the r3itosap.cfg file to 
determine which SAP Systems are to be monitored. You need to ensure that you have 
entered in the Host Mapping section of the r3itosap.cfg file the names of the nodes 
in the high-availability cluster. For more information, see Configuring the SPI for SAP 
in a Cluster Environment on page 66. 
The SPI for SAP in a High-Availability Environment 63 



Installing the SPI for SAP in a Cluster Environment


To use the SPI for SAP in a high-availability environment, you have to install the HPOM 
agent, the SPI for SAP instrumentation, and policies on all nodes in the cluster where the 
SAP package can run—this means, both the primary node and secondary node(s). 

It is always a good idea to make sure that the daily backup of the SAP environment is 
correctly set up and that there is a valid backup available for restore before you start 
the installation of the SPI for SAP actions, commands, monitors, and policies. 

Before you deploy the SPI for SAP to the cluster nodes, you need to deploy the appropriate SPI 
for SAP policies. For example, you have to deploy a central-instance policy group such as SAP 
R3 6.xCI to all managed nodes, where a package that includes a SAP R/3 6.x central instance 
runs or the policy group SAP R3 7.0CI/7.1kernel to all managed nodes where a package 
that includes a SAP R/3 7.0 central instance runs. 

If no SAP instance is running on the node, the SPI for SAP monitors will work immediately 
after installation, but will not generate any messages. 

However, the r3status monitor sends an SAP System down message after you run the 
monitor for the first time. The HostMapping entry in the r3itosap.cfg file maps the 
physical hostname of the system to the virtual hostname of the central instance. The message 
browser indicates that this message originates from the virtual hostname. If the r3status 
monitor on the other node (where SAP is running) also runs for the first time, the monitor 
will send an SAP System up message, which again appears to be arriving from the virtual 
hostname. In effect, there will be two contradictory messages from the virtual host at the 
same time. The order of these messages cannot be predicted. This event occurs only for the 
first r3status run because initially the r3status.his files are not available on each node. 
The r3status monitor sends messages only if the current status of the node is different from 
the status at the last run, which is maintained in the r3status.his file. 

Note that SPI for SAP tools which open a SAP dialog will return an error if you try to execute 
them on a stand-by node, where no SAP package is running. 

If an application-server instance is already running on the managed cluster-node, the 
monitors will run and generate messages relating to the Application-server instance. You 
should configure the monitors that normally only run on a central-instance server in such a 
way that, when they start after a package switch, they do not generate messages relating to 
problems with the Application-server instance, too, since this could lead to the generation of 
duplicate or misleading messages. For more information, see Special-Case Scenarios on 
page 70. 

Installing the SPI for SAP Monitors 

You install the SPI for SAP monitors in a high-availability environment in the same way as in 
a normal environment, that is; using the standard HPOM policy-deployment mechanisms. 
The only difference is that you have to perform the operation once for each physical node in 
the cluster, as follows: 

1 Pre-requisites: 
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Before you start the installation of the SPI for SAP monitors described in this section, 
make sure that you have completed all the steps described in the section Configuring 
SAP-Specific Tasks on page 29, which walks you through the process of setting up the 
appropriate accounts, logins, paths, and permissions required to ensure that SAP and 
HPOM can communicate efficiently. 

If you do not ensure that the appropriate user accounts and permissions have been set 
up in both SAP and HPOM before you start the installation and configuration of the 
SPI for SAP described in this section, the SPI for SAP action, commands, and monitors 
will not function correctly. This could lead to the generation of incorrect or duplicate 
messages and the collection of misleading performance data. 

2 Set up the r3itosap.cfg file to reflect the high-availability cluster. 

You need to enter information about the configuration of the high-availability cluster in 
the Host-mapping section of the r3itosap.cfg file: the r3itosap.cfg file is the file you 
use to specify the SAP Systems, which you want to monitor with the SPI for SAP. For 
more information about the r3itosap.cfg file, see Specifying SAP Systems to Monitor 
on page 39. 

3 Check the monitor configuration: 

Configure the SPI for SAP monitors, which you want to run on the cluster nodes. The 
configuration must be identical for all the nodes in the high-availability cluster in order to 
avoid the generation of confusing messages and potentially misleading performance data 
after a package switch. For more information, see Setting Up Configuration Values for the 
SPI for SAP Monitors on page 34. 

The only exception to this rule is when the adoptive node is already configured as an 
application server. For more information, see Special-Case Scenarios on page 70. 

4 Deploy the SPI for SAP components: 

Use the HPOM console to deploy the appropriate SPI for SAP components to each physical 
node in the cluster. The policies you deploy must match the version of SAP, which is 
running on the managed node. In addition, you must make sure that you deploy exactly 
the same components (instrumentation and policies) to all the nodes in the cluster. In this 
way, you ensure that the SPI for SAP continues to monitor the same SAP instances in the 
same way, regardless of where the SAP instance is running. 

For more information about deploying SPI for SAP components to HPOM managed nodes, 
see Configuring HPOM Administration Tasks on page 39. You will need to complete all 
the instructions for each node in the high-availability cluster. 

5 Special considerations: 

On each node in the high-availability cluster, ensure that each monitor can see its history 
file, r3<monitor_name>.his, both before and after a failover package switch by setting 
the history path in each monitor’s configuration file, r3<monitor_name>.cfg. For more 
information about the location of SPI for SAP monitor history files and the options you 
need to set and change, see Monitor History Files in a High-availability Cluster on 
page 68. 
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Configuring the SPI for SAP in a Cluster Environment 

In a high-availability cluster where the primary and secondary nodes have identical roles, you 
approach the process of configuring the SPI for SAP in the same way as if you had to configure 
the SPI for SAP twice, with the following caveats: 

1 SAP logins and user accounts for the SPI for SAP 

Use the HostSapAssign section in the r3itosap.cfg file to set up the SAP logins, 
accounts and so on required by the SPI for SAP on all physical nodes in the cluster. For 
more information, see Defining SAP Logins in a High-availability Environment on 
page 70. 

2	 Tell the SPI for SAP about the high-availability cluster nodes, which you want 
to monitor. 

You need to enter information about the configuration of the high-availability cluster in 
the Host-mapping section of the r3itosap.cfg file: the r3itosap.cfg file is the file you 
use to specify the SAP Systems, which you want to monitor with the SPI for SAP. For 
example, you need to specify the names of the physical hosts in the high-availability 
cluster and the name of the virtual or relocatable host with which you want to associate 
the messages originating from the cluster when the messages appear in the HPOM 
console. You might also need to specify the name of the host defined in SAPLOCALHOST, 
but only if it is different from the host you want to associate with incoming messages. 

If the HPOM agents are running on the physical nodes in the cluster, you must 
perform an additional, manual, configuration step to ensure that messages in the 
console display the correct node name. For more information, see Host Mapping on 
Cluster Nodes on page 67. 

For more information about the r3itosap.cfg file, the entries you need to add to the 
host-mapping section, and the required syntax, see Specifying SAP Systems to Monitor on 
page 39. 

3	 Configure the SPI for SAP Monitors 

You have to configure the SPI for SAP monitors in exactly the same way on all the 
physical nodes in the cluster, where the package is configured to run. For more 
information about configuring the SPI for SAP monitors, see Configuring the SPI for SAP 
Monitors on page 42. 

A local configuration that is specific to one particular node in the cluster is not 
recommended as it can lead to a situation where different monitoring conditions are 
applied after a package is switched. Special-Case Scenarios on page 70 describes one or 
two exceptions to this rule. 

4	 Deploy the SPI for SAP components 

In this task, you assign and distribute the appropriate SPI for SAP components to all the 
physical nodes in the high-availability cluster, where the package is configured to run. For 
more information about deploying the SPI for SAP components, see Deploying SPI for 
SAP Policies to Managed Nodes on page 43. 

5 History files for the SPI for SAP Monitors 

Make sure that the correct history file is available for each SPI for SAP monitor both 
before and after a failover package switch. For more information, see Monitor History 
Files in a High-availability Cluster on page 68. 

6 Special Requirements in your SAP environment 
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Make sure that any special requirements in your SAP environment are known to the SPI 
for SAP monitors. For more information, see Special-Case Scenarios on page 70. 

If the secondary node in the cluster has the additional role of application server, make 
sure you read the instructions in Special-Case Scenarios on page 70 before you start 
the configuration process. 

Host Mapping on Cluster Nodes 

If the HPOM DCE agent discovers that multiple IP addresses are assigned to a single 
physical node in the high-availability cluster, the messages the agent sends show the host 
name associated with the IP address that is registered on the HPOM management server 
for the cluster node. This is the name of the node where the cluster package is running at 
the time the message is sent. 

Although this behavior is a feature of the HPOM DCE agent in cluster environments, it 
overrides the SPI for SAP’s host-mapping functionality, which can lead to a situation 
where the wrong name appears to be associated with messages displayed in the console. 
To ensure that the host-mapping feature works as intended and the correct host name is 
displayed in SPI for SAP messages coming from the high-availability cluster, you must 
disable the DCE agent feature on HPOM nodes, as follows: 

1	 Log on as a user with administrative privileges to each physical node in the 
high-availability cluster where an HPOM DCE agent is running and open a command 
shell. 

2	 Locate and open the opcinfo file for editing; you can find the opcinfo file in the 
following locations: 

•	 UNIX and Linux operating systems: 

/opt/OV/bin/OpC/install/opcinfo 

•	 Microsoft Windows operating systems: 

%OvAgentDir%\bin\OpC\install\opcinfo 

3	 For DCE agents managed by HPOM, use the keyword 
OPC_SET_PROXY_FLAG_FOR_IP_ADDRESSES in the opcinfo file on each physical node in 
the high-availability cluster to specify the IP address of the package (the virtual node) 
that you want to replace the cluster-node name as registered on the HPOM management 
server, when a message from one of the cluster nodes appears in the console. For example: 

OPC_SET_PROXY_FLAG_FOR_IP_ADDRESSES <Pkg_IP_Address> 

If your high-availability cluster has multiple packages running (for example, for SAP and 
for Oracle), use commas "," to separate multiple IP addresses in the list, as follows: 

OPC_SET_PROXY_FLAG_FOR_IP_ADDRESSES \ 

<SAP_Pkg_IP_Address,Oracle_Pkg_IP_Address,...>.


Spaces are not allowed in the list of IP addresses defined by 
OPC_SET_PROXY_FLAG_FOR_IP_ADDRESSES. Never include the IP address 
specified in OPC_IP_ADDRESS in the list of IP addresses. 

4 Restart the agent with the new configuration using the following commands: 

opcagt -kill; opcagt -start 

Setting the proxy flag in the opcinfo file shows how to set the proxy flag in the opcinfo file. 
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----------------------------------------------------------------

Setting the proxy flag in the opcinfo file 

#############################################################

# File:      opcinfo

# Description:  Installation Information of HPOM Managed Node

# Package:    HP Operations

#############################################################

OPC_INSTALLED_VERSION A.07.29

PERF_INSTALLED_VERSION A.07.27

SVCDISC_INSTALLED_VERSION A.07.28

COMM_INSTALLED_VERSION 2.6.8.0

OPC_MGMT_SERVER pc057.test.test

OPC_INSTALLATION_TIME 01/15/06 16:58:51

OPC_SG FALSE

OPC_SET_PROXY_FLAG_FOR_IP_ADDRESSES 12.34.67.89


Monitor History Files in a High-availability Cluster 

The SPI for SAP alert monitors r3monal, r3mondev, r3monpro and r3status have their 
own history file with the extension .his, for example; r3monal.his. Each time one of these 
SPI for SAP monitors starts, it relies on the contents of its history file 
r3<monitor_name>.his to determine the last events monitored and, as a result, the point at 
which the current monitor run should start. This mechanism is designed to avoid the problem 
of duplicate messages. 

Note that r3monal writes new information to their respective history files only if the SAP 
System they are monitoring is available and the SPI for SAP monitors can connect. If the SAP 
System being monitored is not available, these monitors only update the time stamp to reflect 
the time of the latest monitor run. The monitors r3mondev, r3monpro, and r3status, on the 
other hand, write to their respective history file after each monitor run whether or not the 
SAP System they are monitoring is available or not. 

The r3monal Monitor’s History File r3monal.his 

#----------------------------------------------------------

# Keyword SAP SAP SAP Last Scan

# System Number Instance Time

LastScannedSystem =SP6 =33 =DVEBMGS33 =1073908785


The history files for the SPI for SAP monitors reside on the managed node where the monitors 
are running in a directory specified in each monitor’s configuration file, 
r3<monitor_name>.cfg. By default, this directory is %OVAGENTDIR%\conf\sapspi for 
Microsoft Windows managed nodes and /var/opt/OV/conf/sapspi for all UNIX managed 
nodes except AIX, which uses the directory /var/[lpp | opt]/OV/conf/sapspi for [DCE 
| HTTPS] managed nodes. 

If the SPI for SAP monitor cannot find or read its history file, it does not know when the last 
monitor run took place and, as a consequence, has no way of determining which alerts need 
reporting and which it can safely ignore. 

If a SPI for SAP monitor cannot find or read its history file, the monitor assumes it is starting 
for the first time and, with the exception of the alert monitor r3moncol which reads the 
relevant tables in the SAP-alerts log database, parses the SAP trace and log files for any 
information gathered in the one day prior to the monitor start time. This could lead to the 
generation of a large number of duplicate messages. 
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If the cluster package switches to another node, then the SPI for SAP monitors can no longer 
access the most recent history files stored on the failed cluster node. This may lead to the 
generation of duplicate messages—messages that have already been sent to HPOM. For 
r3monal, the duplicate messages can be avoided by enabling CCMSAcknowledgeMessage. 
Refer to the r3monal: CCMS Acknowledge Message section of the SPI for SAP Administrator’s 
Reference for more information on CCMSAcknowledgeMessage. 

The r3moncol monitors keep their history information in the SAP tables. As a result, they do 
not have a .his history file. The r3mondev monitor reads the SAP trace and log files, and 
keeps the line number for each file in r3mondev.his. Therefore, in principle, r3mondev is 
prone to sending duplicate messages if the package is switched to the other node. If 
r3mondev.his is stored on the local disks and r3mondev on the new node, the SPI for SAP 
starts scanning from a point that was scanned on the previous node already. 

However, after starting an SAP instance, new dev_* files will be created. Most of the dev_* 
files will be copied to dev_*.old files before creating new files. Therefore, r3mondev never 
monitors the dev_*.old files. 

r3mondev detects (through the Inode column in r3mondev.his) if a file is created new, and 
then starts scanning the new file from the beginning. Therefore, you can use the default 
configuration for r3mondev and it is not necessary to place r3mondev.his on a shared disk. 

Special Considerations for the Alert Monitors 

This section contains information which is intended to help you set up the SPI for SAP alert 
monitors in a high-availability environment. For more detailed information about the 
alert-monitor configuration files and keywords for r3monal in particular, see the HP 
Operations for Windows Smart Plug-in for SAP Administrator’s Online Help. To set up the 
SPI for SAP alert monitors in a high-availability environment, you need to carry out the 
following steps: 

1	 Enable (=1) the r3monal monitor’s auto-acknowledgement feature for CCMS alerts in 
SAP to avoid duplicate messages appearing in the HPOM console 

2	 Define a CCMS Monitor Set, for example; "HPOM", and a CCMS Monitor, for example; 
"SPI Monitoring", for the messages you want to forward from CCMS to the HPOM 
console. Note that the monitor-set feature can be only used with the XMI/XAL interface. 

CCMS Monitor Sets on page 69 shows which parameters you should use in r3monal.cfg file 
to set up the r3monal monitor to use the XMI/XAL interface, which is available with SAP 4.6 
and higher and must be enabled for the r3monal monitor in a cluster environment. 

CCMS Monitor Sets 

# Triggers auto-acknowledge of CCMS alerts

#-----------------------------------------------------------

# CCMSAcknowledgeMessage SAP Ack. filtered Enable=1

# System Messages Disable=0

CCMSAcknowledgeMessage =SP6 =0 =1


# A Monitor Set defines the messages you want to forward to

# the HPOM console. 

#-----------------------------------------------------------

# Monitor Set SAP SAP Monitor Set Monitor 

# System Number   

CCMSMonitorSet =SP6 =33 =HPOM =SPI-Monitoring 
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-------------------------------------------------------------

In addition, in order to prevent r3monal sending duplicate messages in the event of a 
package failover, you have to use the keyword CCMSAcknowledgeMessage to enable the 
r3monal monitor’s auto-acknowledgement feature for CCMS alerts in SAP. This feature 
automatically acknowledges CCMS Alerts in SAP so that they are not repeatedly found by the 
SPI for SAP and used to generate messages. 

Defining SAP Logins in a High-availability Environment 

When setting up the SPI for SAP in a high-availability environment, remember to include 
references to SAP instances running on all physical nodes in the cluster in the r3itosap file, 
the file which the SPI for SAP uses to define all SAP logins. When you enter the information 
for the SAP logins in this file, it is essential that you use the names of the physical nodes in 
the high-availability cluster, since the SPI for SAP monitors reference the physical node (and 
not the relocatable IP address associated with the package) when they do a host-name lookup. 
For more information about specifying SAP logins in a cluster environment, see Specifying 
SAP Systems to Monitor on page 39. 

The SPI for SAP uses the host-mapping section of the r3itosap.cfg file to define 
information about the configuration of the high-availability cluster, such as the names 
of the physical hosts and the name of the managed node to be associated with 
messages originating from the cluster. For more information, see Configuring the SPI 
for SAP in a Cluster Environment on page 66. 

If the secondary node in the high-availability cluster is already configured as an application 
server, then the logins for both the central instance (=CI) and the application server (=APP) 
can lead to problems with some of the SPI for SAP components, for example; r3moncol and 
r3monpro, both of which require special configuration as described in Special-Case Scenarios 
on page 70. 

To ensure that automatic or operator-initiated actions are always able to open an SAP GUI on 
the virtual node in the high-availability cluster, add a HostSapAssign entry to the 
r3itosap.cfg file, which specifies the host name defined in the variable SAPLOCALHOST. 

Special-Case Scenarios 

For reasons of efficiency or cost, the secondary node in a high-availability cluster might 
already be in use as an application server. If this is the case in your environment and regular 
high loads mean that you need the central instance to maintain the same performance level 
after the failover package switch as before, you have the option of shutting down the 
application server on the secondary node after the failover so that the machine’s performance 
is available solely to the central instance. You can then share the user load between any other 
available application servers. 

If performance is not an issue in your environment, you can choose to keep the application 
server instance running on the secondary node even after the failover package switch. 
However, if an instance of an SAP application server is running on the same machine as an 
SAP central instance, you will need to ensure that the SPI for SAP monitors are made aware 
of this fact and do not generate messages for both the central-instance and the 
Application-Server. The SPI for SAP monitors which are only designed to work with the 
central instance should be set up to exclude monitoring of the Application-Server instance. 
The r3moncol and r3monpro monitors, for example, require special attention. 
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Each SPI for SAP monitor has a configuration file that you use to define which SAP instances 
in your SAP landscape it should watch and, in addition, what information it should collect. 
For example, you use the r3monpro.cfg file to configure the r3monpro monitor to collect 
information about either the central-instance processes or the processes tied to the 
Application-Server instance. Note that the HP Operations for Windows Smart Plug-in for SAP 
Administrator’s Online Help has much more information about the individual SPI for SAP 
monitors as well as additional hints about what aspects you can configure to suit the 
requirements of your environment. 

The SAP instance number associated with the application server already running on 
the adoptive node cannot be the same as the SAP instance number associated with the 
SAP central instance, which starts on the secondary node after the failover package 
switch. 

Table 1 shows which monitors apply to which SAP instance types. 

Table 1 SPI for SAP Monitors and SAP Instance Types 

SPI for SAP Monitor 
Name Central Instance 

Application 
Server 

r3monaco ✓ 

r3monale ✓ 

r3monal a ✓ 

r3monchg ✓ 

r3moncts ✓ 

r3mondev ✓ ✓ 

r3mondisp ✓ ✓ 

r3mondmp ✓ 

r3monjob ✓ 

r3monlck ✓ 

r3monoms b ✓ 

r3monpro ✓ ✓ 

r3monrfc ✓ 

r3monsec ✓ 

r3monspl ✓ 

r3status ✓ ✓ 

r3montra ✓ 

r3monupd ✓ 

r3monusr ✓ 

r3monwpa ✓ 

a. CCMS 4.x only 
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b. Due to changes in SAP, the operation-mode monitor r3monoms 
is not supported with WebAS 7.0. 

The r3moncol Monitor in a High-Availability Cluster 

The r3moncol monitor collects alerts from all the SPI for SAP alert-collector monitors such as; 
r3monale, the iDOC-Status Monitor, and r3mondmp, the ABAP-dump monitor. The alert 
monitors themselves ensure that alert collectors are executed according to a defined schedule 
and report any messages that come back from the called function. 

The r3moncol monitor is only intended to run on an SAP central instance: it is not designed to 
run on an application server. As a consequence, if the secondary node in a high-availability 
cluster is running an application server, care has to be taken to ensure that the monitors that 
are started when the central instance comes up on the secondary node after the failover 
switch do not become confused about which SAP instance to monitor—application server or 
central instance. 

To avoid problems when the central instance and the application server are running on the 
same cluster node at the same time, for example; after a system failover, you need to ensure 
that each of the monitors which the r3moncol starts when the central instance comes up on 
the secondary node is configured to ignore alerts associated with the application server and 
monitor only those alerts that belong to the central instance. This means modifying the 
configuration file of each of the SPI for SAP’s central-instance monitors listed in Table 1 on 
page 71 in such a way as to make sure that the monitor is tied to a particular SAP 
central-instance number, for example; 00. By default, the SPI for SAP monitors are configured 
to monitor all SAP instances present on the node, which in this special-case scenario would 
include the unwanted Application-Server instance, too. 

Tying the r3monale Monitor to an SAP Instance Number illustrates how the configuration file 
for the r3monale monitor on the adoptive node would look if you configured r3monale to 
monitor only the central instance (for example=00) on the secondary node nodename2.com and 
not the instance of the application server (=01), which is already running. Note that the node 
name you specify in this file is the name of the physical cluster node: <CI> refers to the SID 
for the central instance. Note, too, that the configuration files illustrated in Tying the 
r3monale Monitor to an SAP Instance Number and Tying the r3monpro Monitor to an SAP 
Instance Number are incomplete (...) and are included in this form only for the purposes of 
illustration. 

Tying the r3monale Monitor to an SAP Instance Number 

#AlertMonFun SAP SAP SAP SAP Alert Enable=1 (...)


# Host System Number Client Monitor Disable=0 (...)


#----------------------------------------------------------------------------


AlertMonFun =ClusterNodeA =CI =00 =099 =ALE =1 (...)


AlertMonFun =ClusterNodeB =CI =00 =099 =ALE =1 (...)


The r3monpro Monitor in a High-Availability Cluster 

The r3monpro monitor scans for and checks all processes associated with a given SAP 
instance, for example; the dialog, enqueue, update, batch, dispatch, message, gateway, and 
spool work processes. However, the r3monpro monitor can be used to monitor database 
processes, too. 
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If the secondary node in a high-availability cluster is running an application server, then care 
has to be taken after a package switch that the r3monpromonitor started by the package does 
not assume that the processes associated with the application server also need to be 
monitored along with the processes belonging to the central instance. One way of ensuring 
this is to specify the exact number of processes to be monitored by r3monpro in the 
r3monpro.cfg file (in the column: Process number=#). The number of processes to monitor 
must be the same on each node both before and after the failover package switch. 

In addition, if you want to ensure that the r3monpro monitors only those processes belonging 
to a specific SAP instance on a node where multiple SAP instances are running, for example; 
after a package switch, you have to make sure that the r3monpro monitor knows which SAP 
instances it is supposed to watch. You can do this by modifying the r3monpro.cfg file on the 
adoptive node in the cluster in such a way that each SAP instance number (defined in the 
column: SAP Num=) is linked to a specific process name, and a defined number of process 
instances, as illustrated in Tying the r3monpro Monitor to an SAP Instance Number. 

Tying the r3monpro Monitor to an SAP Instance Number 

#AlertInstMonPro SAP SAP Process Enable Mode Proc (...)

# Sys Num Name =1 Num (...)

#------------------------------------------------------------------

AlertInstMonPro =T11 =00 =dw.sapSID* =1 =Min =9 (...)

AlertInstMonPro =T11 =01 =dw.sapSID* =1 =Min =6 (...)


Performance Tools in a Cluster Environment 

If you are using the Performance Agent (or HP Software Embedded Performance Component) 
to monitor SAP in a high-availability environment, you must install the performance agents 
on both nodes in the cluster, namely; the primary and secondary nodes, and then configure the 
performance agent to monitor the same SAP System IDs on both nodes. 

Since r3perfagent will always use the physical hostname in a cluster environment, you must 
specify the clustered SAP-system details by configuring r3perfagent with the manual mode 
(888). If you are configuring r3perfagent on a physical cluster node, r3perfconfig may offer 
you the option (x) on the SAP system with the virtual node. In this case, use the manual 
configuration (888) by specifying the physical cluster node name. 

In the event of a failover and subsequent package switch, the Performance Agent stops 
collecting values for the SAP metrics on the host node and, as soon as the package comes up 
on the adoptive node, starts to monitor and report the appropriate SAP metrics on the 
secondary node. Metrics for physical components such as CPU and disk performance continue 
to be collected on both nodes irrespective of where the package is running. This needs to be 
taken into account when generating and publishing performance reports and graphs. 

The SPI for SAP service reports do not correlate the values collected by the Performance 
Agent on the cluster over time. The reports process the data separately for each cluster node. 
This means that if a package switches from the primary node to the secondary (backup) node, 
the values for the switched instance will be split between the two nodes in the cluster. If the 
scenario described reflects the situation in your environment, you will have to use the reports 
from both nodes to get a complete view of SAP performance. 
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Service Reports and Performance Graphs in a Cluster 
Environment 

If you want to generate SPI for SAP service reports and performance graphs for all the nodes 
in the high-availability cluster, make sure that both the HP Performance Manager and HP 
Reporter are installed, correctly configured, and running on a machine which can see the 
cluster nodes. You will also have to ensure that the appropriate performance-agent 
functionality (HP Software Embedded Performance Component or the HP Performance 
Agent) is installed, configured, and available on all the physical nodes in the high-availability 
cluster and the appropriate SPI for SAP R/3 Performance Agent integration functionality is 
installed and correctly configured. 

Note that operating system reports are tied to the individual physical nodes in the cluster. 
This means that the SPI for SAP monitors are collecting operating system data even when the 
SAP package is not running, for example; on the secondary (backup) node. 

You can generate reports and graphs for the high-availability cluster using SAP-, hardware-, 
and network-related metrics, which the performance agents collect from the physical nodes in 
the cluster. Since the Performance Agents run on all the physical nodes in the cluster and are 
independent of the SAP package, reports which use hardware- or network-related metrics can 
even be configured to include the periods during which the SAP package is not running, for 
example; on the secondary node before a package switch and on the host node after the 
package switch. Note that SAP-related metrics such as status and availability are linked to 
the physical node where (and during the time which) the package is running. 

Service Views in a Cluster Environment 

You can use tools provided by the SPI for SAP to generate Service Views of the SAP 
environment automatically. If you want to make use of Service Views with the SPI for SAP, 
you need to set it up to see the services you want the SPI for SAP to monitor in the SAP 
landscape and ensure that incoming messages are linked to the correct physical nodes in the 
cluster. 

The service-discovery policy needs to be able to read the r3itosap.cfg file to determine the 
SAP Systems which the SPI for SAP is monitoring and, more specifically, the host-mapping 
section. The information in the host-mapping section of the r3itosap.cfg file specifies the 
names of the nodes in the high-availability cluster and, in addition, which node name should 
be associated with messages generated by nodes in the cluster. For more information about 
the contents of the r3itosap.cfg file, see Configuring the SPI for SAP in a Cluster 
Environment on page 66 and Specifying SAP Systems to Monitor on page 39. 

Only physical nodes can appear in the service tree, and data can only be collected for 
the physical node on which the package is running at a given point in time. 
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Removing the SPI for SAP Software in a Cluster Environment 

The SPI for SAP software and functionality has to be removed from each individual physical 
node in the high-availability cluster, where the product was installed and configured. This will 
involve the following steps: 

1 If you installed the SPI for SAP R/3 Performance Agent on the managed nodes in the 
cluster, you will have to remove it and its components from the SAP managed nodes in the 
high-availability cluster before you proceed to step two. For more information, see 
Uninstalling the SPI for SAP on page 113. 

2	 After removing the SPI for SAP R/3 Performance Agent, you have to remove the SPI for 
SAP components from the SAP managed nodes in the high-availability cluster. For more 
information, see Removing SAP-management Functionality from Managed Nodes on 
page 113. 
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8 Smart Plug-in for SAP Performance Monitors

This section describes how to install and configure the SPI for SAP performance-integration 
package. It also provides information about how to put the performance monitors to best use 
and supplement the information provided by the SPI for SAP performance monitors with 
information supplied by the Performance Agent. 

Performance Monitors Overview 

The SPI for SAP performance monitors collect SAP performance data which can then be used 
to compare trends between SAP business transactions and other system metrics. The 
performance monitors can be used to monitor, manage, and correlate the collected data 
centrally along with any other application, database, system and network data. 

The SPI for SAP accesses ABAP-function modules inside SAP by using an RFC-call. The 
performance monitors gather a snapshot of SAP runtime performance data. Including the 
SAP-performance alert monitor (rz03) which is part of the SAP CCMS subsystem, the SPI for 
SAP Performance Agent is able to collect over 100 additional metrics. 

The new SPI for SAP Performance Agent can be configured to specify which performance 
monitors should be run on which SAP instances and how frequently. The Performance Agent 
or HP Software Embedded Performance Component send an alert to the HPOM management 
server when they detect the violation of a defined performance threshold. 

The SPI for SAP Performance Agent runs under Windows as a service and under Unix as a 
daemon process that runs independently of the HPOM agent processes. In order to start or 
stop the SPI for SAP performance-agent processes, use the appropriate HPOM tools, which 
you can find in the HPOM console. 

Upgrading the Performance Monitor 

You cannot always use the data sources you defined in previous versions of the SPI for SAP R/ 
3 Performance Agent with the latest version of the SPI for SAP R/3 Performance Agent: 
sometimes you have to migrate the data to the new format required by the current release of 
the SPI for SAP. Whether you can or cannot use existing data-sources with the current 
version of the SPI for SAP depends on whether you are upgrading from a recent or (much) 
older version of the SPI for SAP. However, HP Reporter can still use the data collected by the 
old performance agents in the generation of new service reports. 

Note, too, that if you want to upgrade the SPI for SAP R/3 Performance Agent, you cannot do 
it in isolation. To upgrade the SPI for SAP R/3 Performance Agent, you will have to perform 
the following high-level steps: 

1 Remove the existing SPI for SAP R/3 Performance Agent. 
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For more information about de-installing the SPI for SAP R/3 Performance Agent, see 
Installing the Performance Monitor on page 78. 

2 Remove existing SPI for SAP R/3 Performance Agent data and data sources 

•	 SPI for SAP 11.10 

If you are upgrading from version 11.10 to the current version of the SPI for SAP, you 
do not need to perform this step; existing data and data sources can continue to be 
used. 

3 Upgrade the SPI for SAP software 

4 Install the new SPI for SAP R/3 Performance Agent software.


For more information about installing the SPI for SAP R/3 Performance Agent, see 

Installing the Performance Monitor on page 78.


5	 Configure the new SPI for SAP R/3 Performance Agent. 

For more information about installing the SPI for SAP R/3 Performance Agent, see 
Configuring the Performance Monitor on page 85. 

6	 Upgrade the SPI for SAP/HP Reporter Integration. 

For more information about upgrading the SPI for SAP Reporter integration, see the HP 
Operations for Windows Smart Plug-in for SAP Administrator’s Online Help. 

Installing the Performance Monitor 

The information in this section walks you through the steps required to install and configure 
the SPI for SAP performance integration. 

The instructions in this section assume the following are true: 

—	 Either the Performance Agent or the HP Software Embedded Performance 
Component is installed. 

—	 The supported SAP version is installed, as listed in Table 3 on page 18. 

—	 The HPOM Enterprise Message/Action Agent is already installed and running on the 
SAP servers, which you want to manage with HPOM. 

Selecting the Performance Data Source 

The HP Software Embedded Performance Component is, as the name suggests, embedded in 
the HPOM software and available, by default, in any HPOM installation. However, you can 
use the HPOM console to deploy the HP Performance Agent to the managed nodes, too. 

If you prefer to use the HP Performance Agent as the agent for newly installed HP software 
products rather than the HP Software Embedded Performance Component (for example, to be 
able to use Performance Manager, which does not support the HP Software Embedded 
Performance Component), you can override the default use of the HP Software Embedded 
Performance Component by setting up a small text file, nocoda.opt, which changes the 
default data source from the HP Software Embedded Performance Component to the HP 
Performance Agent. 
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After configuring the nocoda.opt file, you must store it in a specific location on each 
managed node, whose performance-data source you want to change. The location of the 
nocoda.opt file on the managed node varies according to the operating system running on 
the HPOM management server and managed node. Table 2 on page 79 displays the location of 
the nocoda.opt files on nodes managed by an HPOM management server. 

Table 2 HPOM 8.x for Windows Management Servers 

Managed-Node 
Operating System 

AIX {DCE | HTTPS] 

HP-UX/Linux/Solaris 

Windows 

Location of the nocoda.opt file 

/var/[lpp | opt]/OV/conf/dsi2ddf/
nocoda.opt 

/var/opt/OV/conf/dsi2ddf/nocoda.opt 

%OvDataDir%\conf\dsi2ddf\nocoda.opt 

Changing Default Settings for the Performance Data Source 

To change the default setting for the data source, use your favorite text editor to open the 
nocoda.opt file on the managed node whose data source you want to modify and follow the 
instructions below. You will need to enter the appropriate information manually using the 
format and syntax illustrated in Table 3 and Excerpt from the nocoda.opt File on page 79. If a 
nocoda.opt file does not already exist, you will need to create a new one. 

1	 To designate the HP Performance Agent as the agent for all data sources, enter the key 
word ALL at the top of the file. 

2	 To designate the HP Performance Agent as the agent for a data source tied to a specific 
SAP instance, include a reference to each instance on a separate line of the nocoda.opt 
file, using the format and syntax indicated in Table 3 and illustrated in Excerpt from the 
nocoda.opt File: 

Table 3 nocoda.opt File Syntax 

For... Use the following format... 

SAP R3_<SAP_hostname>_<SAPSID>_<SAP_instance_ 
NetWeaver number>_DATA 

3	 Save the changes to the nocoda.opt file. 

4	 Restart the HPOM agent on the managed node where the nocoda.opt file has been 
modified. 

Excerpt from the nocoda.opt File 

###########################################

# Add to (or modify) the contents of this file to change the 

# data-source from the default Coda to MeasureWare

###########################################

# All hosts: 

# ALL 

# SAP R/3 hosts/instances: 
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R3_ovsdsap_DEV_00_DATA 

Deploying the Performance Monitor Packages 

The instructions in this section describe how to deploy the SPI for SAP performance-monitor 
instrumentation from the HPOM management server to the HPOM managed node systems. 

1 From the HPOM console, select and right-click the SAP managed (s) where you want to 
deploy the instrumentation. 

2 Browse to the following menu option: 

All tasks > Deploy instrumentation 

3 Select the following files as illustrated in Figure 4: 

• SAP Instrumentation 

4 Select OK. 

Figure 4 Deployment Package Selection 

Installing the SPI for SAP Performance Packages 

After you successfully complete the deployment of the SPI for SAP performance packages as 
described in the previous step, follow the instructions in this section to install the SPI for SAP 
performance packages on the HPOM managed nodes: 

1 From the HPOM console, browse to the following tools folder: 

Tools > SPI for SAP > SAP R/3 Admin 

2 Select and right click the tool corresponding to your operating system (Unix or Windows), 
for example; Install Performance Package (UNIX), and select the following option from 
the menu that pops up: 

All Tasks > Launch Tool... 
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3 Select the SAP managed node(s) where you want to start the SPI for SAP performance 
package installation, as illustrated in Figure 5 below. Remember to ensure that the nodes 
you select correspond to the operating system associated with the chosen tool (UNIX or 
Microsoft Windows). 

4 Click Launch... to start the installation. 

Figure 5 Installing the Performance Package 

Uninstalling the SPI for SAP Performance Packages 

The procedure for removing the SPI for SAP performance package from a managed node is 
very similar to the procedure described in Installing the SPI for SAP Performance Packages 
on page 80 except that, at the appropriate moment, you select and launch the removal tool 
rather than the installation tool. 

Note that you must stop the performance agent before removing the SPI for SAP 
performance package and, after the removal is complete, you need to remove the SPI 
for SAP performance monitor from the managed nodes, too. For more information 
about stopping and starting the performance agent, see SPI for SAP Tools on page 91 
and Command-Line Options on page 90. 

To remove SPI for SAP performance packages from SAP managed nodes: 

1 Stop the SPI for SAP performance agent. You can do this either with a SPI for SAP tool, or 
on the command line: 

•	 Use the SPI for SAP application, PerfAgt Stop, which you can find in the SAP R/3 
UN*X or SAP R/3 NT tools group. 
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•	 Login to the SAP server (managed node) and run the following command on the 
command line: r3perfagent stop 

2 From the HPOM console, browse to the following tools folder: 

Tools > SPI for SAP > SAP R/3 Admin 

3 Select and right click the tool corresponding to your operating system (Unix/Linux or 
Microsoft Windows), for example: 

•	 Remove Performance Package (UN*X) 

•	 Remove Performance Package (Windows) 

4	 Start the Remove Performance Package tool you have selected using the following menu 
option: 

All tasks  > Launch Tool... 

5	 Select the SAP managed node(s) from which you want to remove the performance 
package. Remember to ensure that the nodes you select correspond to the operating 
system for the chosen tool (UNIX/Linux or Microsoft Windows). 

6	 Click Launch... to start the removal process. 

Figure 6 Stopping the Performance Agent 

Locating the Performance Monitor Files 

The information in this section describes the files installed as part of the SPI for SAP 
performance package for the following platforms, for example: 

•	 Performance Monitor Files on AIX on page 83 
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•	 Performance Monitor Files on HP-UX, Solaris, and Linux on page 83 

•	 Performance Monitor Files on Windows on page 84 

The performance-related files listed in this section belong to the following categories: binaries 
and executable files, configuration files, the dsilog files required by the HP Performance 
Agent, and templates. 

The dsilog files are only required by the HP Performance Agent; the HP Software 

Embedded Performance Component does not require or make use of the dsi log files.


Performance Monitor Files on AIX 

This section lists the files installed as part of the SPI for SAP performance package for AIX. 
The paths distinguish between [DCE | HTTPS] managed nodes: 

•	 Binaries: /var/[lpp | opt]/OV/bin/R3PerfAgent/bin 

—	 r3perfconfig


SPI for SAP performance-monitor configuration tool. 


—	 r3perfagent


SPI for SAP performance-monitor agent.


•	 Configuration files: 
/var/[lpp | opt]/OV/conf/sapspi/[local | global] 

—	 r3perfagent.cfg 

Global and local configuration file for the various performance monitors. 

•	 Dsilog files: /var/[lpp | opt]/OV/bin/R3PerfAgent/data 

—	 R3_<HOSTNAME>_<SID>_...: 

Immediately after installation, this directory is empty; the SPI for SAP uses the 
directory to store the dsilog files, which r3perfconfig and compdsifile.sh
compile for the HP Performance Agent. 

•	 Templates: /var/[lpp | opt]/OV/bin/R3PerfAgent/template 

—	 R3statistics.<PERF-MONITOR>


Files the SPI for SAP uses to compile the dsi log files.


—	 Parm.UX: 


Template for the performance-agent parameter file. 


Performance Monitor Files on HP-UX, Solaris, and Linux 

This section lists the files installed as part of the SPI for SAP performance package for 
HP-UX, Solaris, and Linux operating systems: 

•	 Binaries: /var/opt/OV/bin/R3PerfAgent/bin 

—	 r3perfconfig


SPI for SAP performance-monitor configuration tool. 


—	 r3perfagent


SPI for SAP performance-monitor agent.
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•	 Configuration files: /var/opt/OV/conf/sapspi/[local | global] 

—	 r3perfagent.cfg 

Configuration file for the various performance monitors. Note that the SPI for SAP 
creates this directory after you deploy the SPI for SAP performance-agent policies for 
the first time. 

•	 Dsilog files: /var/opt/OV/bin/R3PerfAgent/data 

—	 R3_<HOSTNAME>_<SID>_...: 

Immediately after installation, this directory is empty; the SPI for SAP uses the 
directory to store the dsilog files, which r3perfconfig and compdsifile.sh
compile for the HP Performance Agent. 

•	 Templates: /var/opt/OV/bin/R3PerfAgent/template 

—	 R3statistics.<PERF-MONITOR>:


Files which the SPI for SAP uses to compile the dsi log files. 


—	 Parm.UX


Template for the performance-agent parameter file. 


Performance Monitor Files on Windows 

This section lists the files installed as part of the SPI for SAP performance package for 
Windows: 

•	 Binaries: %OvDataDir%\bin\R3PerfAgent\bin 

—	 r3perfconfig


SPI for SAP performance-monitor configuration tool. 


—	 r3perfagent


SPI for SAP performance-monitor agent.


—	 r3perfagent_service 

Starts the SPI for SAP performance-monitor agent as a service in Microsoft Windows. 

•	 Configuration files: %OvAgentDir%\conf\sapspi\global 

—	 r3perfagent.cfg 

Configuration file for the various SPI for SAP performance monitors. Note that the 
SPI for SAP creates this directory after you deploy the SPI for SAP performance-agent 
policies for the first time. 

•	 Dsilog files: %OvDataDir%\bin\R3PerfAgent\data 

—	 R3_<HOSTNAME>_<SID>_... 

Immediately after installation, this directory is empty; the SPI for SAP uses the directory 
to store the dsilog files, which r3perfconfig.bat and compdsifile.bat compile for 
the HP Performance Agent. 

•	 Templates: %OVDATADIR%\bin\R3PerfAgent\template 

—	 R3statistics.<PERF-MONITOR>


Files which the SPI for SAP uses to compile the dsi log files. 


—	 Parm.NT 
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------------------------

Template for the performance-agent parameter file. 

Configuring the Performance Monitor 

Before starting to configure the performance monitor note that if the Performance Agent is 
used instead of HP Software Embedded Performance Component, then you need to stop the 
Performance Agent on the managed node using the commands listed in Table 4 appropriate to 
your system environment: 

Table 4 Stopping the Performance Agent 

Platform 

AIX 

HP-UX/Solaris/Linux 

Microsoft Windows 

Command 

/usr/lpp/perf/bin/mwa stop 

/opt/perf/bin/mwa stop 

mwacmd stop 

After you stop the HP Performance Agent, you can proceed with the configuration of the 
performance monitor. Note that if you are using the HP Software Embedded Performance 
Component, you do not need to perform any special action before you start configuring the 
performance monitor. 

This section also includes information about using the SPI for SAP to monitor performance 
thresholds on remote machines, where the SPI for SAP in not installed. The information in 
this section also explains the concepts underlying the Performance-monitor scheduler, which 
ensures that the performance monitors run according to the defined schedule: 

• Monitoring System-Performance Remotely on page 89 

• The Performance-Monitor Scheduler on page 90 

To Configure the Performance Monitor, follow these steps: 

1 On the node where you installed the SPI for SAP performance monitor, locate and enter 
the following command to run the configuration script: 

• Microsoft Windows operating systems: r3perfconfig 

• UNIX and Linux operating systems: ./r3perfconfig 

Follow the instructions which appear on screen. Installed SAP Instances shows how the 
script lists the SIDs it finds together with a number (SapNr), and prompts you to select 
the SAP NetWeaver instance to be configured. 

Installed SAP Instances 

SID SapNr HostName 

(0) AST 45 sapper 
(1) DEV 50 sapper 
(2) SP1 80 sapper 
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-------------------------------------------

Choose: 
(x) to configure shown system
888 to manually configure a SAP system
999 to quit 

Enter the appropriate identification number, for example; 0 for AST, or 1 for DEV, 2 for 
SP1, or 888 to configure a new SAP System. 

a	 If a valid data source already exists for the given SAP System ID, r3perfconfig lists 
the data source and prompts you to select an option, as follows: 

Choose: 
(x) to configure shown system

888 to manually configure a SAP system

999 to quit

0

Valid datasource already exists: R3_sapper_AST_45_DATA


b	 If r3perfconfig finds an existing data source, which it can migrate to the required 
new format, it lists the old data source and asks you what to do: 

Choose: 
(x) to configure shown system

888 to manually configure a SAP system

999 to quit

1

Found an old datasource: R3_sapper_DEV_50_DATA

Should the existing datasource be migrated <yes/no>?


Note the following before you respond to the prompt: 

yes	 automatically migrates the old data source to the format required by 
the new version of the SPI for SAP performance agent 

no	 leaves the existing data source unchanged: the old data source cannot 
be used with the new version of the SPI for SAP performance agent 

c	 If r3perfconfig finds an existing data source which cannot be migrated to the new 
format, for example; because it belongs to a version of the SPI for SAP that is older 
than 10.70, it lists the old, invalid data source and prompts you to select an option, as 
follows: 

Choose: 
(x) to configure shown system

888 to manually configure a SAP system

999 to quit

2

Found an invalid datasource: R3_sapper_SP1_80_DATA

Existing datasource cannot be migrated


d	 If you choose 888 to configure an SAP SID manually, you have to answer a series of 
questions concerning the SAP SID you want to configure. To answer these questions, 
you might need to talk to an SAP administrator. 

After you finish migrating the performance data, the dsilog files are compiled and the 
data sources added to the HP Performance Agent configuration file, namely: 

—	 perflbd.rc for UNIX and Linux operating systems 
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— perflbd.mwc for Microsoft Windows operating systems 

If you are using the HP Software Embedded Performance Component, the names 
of the configuration files are ddflbd.rc for UNIX and Linux operating systems 
and ddflbd.mwc for Microsoft Windows operating systems. 

After completing the data migration, the r3perfconfig script prompts you to restart the 
Performance Agent. However, it makes sense to update the parm.mwc file as described in 
the next step before you start the Performance Agent. 

2 Update the Performance-agent parameter file 

This step does not apply to the HP Software Embedded Performance Component. 

If you are using the Performance agent, append the template file parm.NT (or Parm.UX, 
depending on the installed operating system on the managed node) to the parm file of the 
Performance agent, as follows: 

•	 UNIX and Linux operating systems: cat parm.UX >> parm


The parm file is located in: /var/opt/perf/parm


•	 Microsoft Windows operating systems: type parm.NT >> parm.mwc


The parm file is located in the following directory:


<drive_letter>\rpmtools\data\parm.mwc 

You can represent several SAP NetWeaver instances in the parm file by using the 
asterisk (*) wild card. 

3	 On the HPOM management server, you configure the SPI for SAP performance monitors 
in the r3perfagent.cfg file. If you do not complete this task, all monitors run with the 
default settings illustrated in Figure 7 on page 89, which could lead to a large number of 
unwanted messages appearing in the HPOM console. 

There are two possible configurations: 

•	 Global: global_r3perfagent.cfg


SPI for SAP performance-monitor settings for all SAP servers 


•	 Local: local_r3perfagent.cfg


SPI for SAP local performance-monitor settings for individual SAP servers


The settings in the global configuration files are used for all nodes which do not 
have local configuration settings. Where both files are present, local settings 
override global settings. 

You should use the configuration-file policy editor to create a new (or modify an existing) 
r3perfagent.cfg file. 

4 To modify an existing configuration file: 

a	 Select the policy view and, in the details pane, select and right-click the appropriate 
r3perfagent.cfg file, and click the following menu option: 

All Tasks > Edit... 

b The r3perfagent.cfg file is displayed as illustrated in Figure 7 on page 89. 

5 To create a new configuration-file: 
Smart Plug-in for SAP Performance Monitors 87 



a	 In the HPOM console tree, expand the Policy Management policy group, select and 
right-click the SPI for SAP policy group, and add a new configuration file by selecting 
the following option from the pop-up menu that appears: 

New > ConfigFile 

b	 Load the default global_r3perfagent.cfg file, change any values as required, and 
save the file. If you want to create a local configuration file, we recommend you 
include the name of the machine for which the local configuration is intended in the 
local-configuration file name as outlined below: 

<machine_name>_r3perfagent.cfg 

You have to deploy the modified policy to the managed node (<machine_name>) and 
restart both the Performance Agent and the SPI for SAP performance monitor in 
order to upload and apply the modified configuration. Note that, by default: 

–	 all SPI for SAP performance monitors are enabled for all SAP hostnames, 
systems, numbers, and clients 

–	 the polling intervals are set for each monitor in minutes 

–	 the Hold-Connections option is disabled 

–	 the Performance-monitor Scheduler sends a message if it is 10 minutes behind 
schedule 

–	 the Performance-monitor Scheduler is set to restart if it is 13 minutes behind 
schedule 

6 Deploy the modified policies: 

a Select and right click the policies you want to deploy 

b Select the Deploy option from the menu which pops up 

7	 Start (or stop and restart) the Performance Agent on the managed node by entering the 
following command in a shell or by using the menu options in the appropriate SPI for SAP 
tools group. 

•	 UNIX and Linux operating systems: 

mwa [stop | start] 

•	 Microsoft Windows operating systems: 

mwacmd [stop | start] 
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Figure 7 The Default Global r3perfagent.cfg File 

8	 On the managed node, locate the r3perfagent command and start (or stop and restart) 
the SPI for SAP performance monitor. For information about locating the SPI for SAP 
performance monitor files, see Locating the Performance Monitor Files on page 82). You 
can control the SPI for SAP performance monitor by using the SPI for SAP tools or 
entering the following commands in a shell on the managed node: 

•	 UNIX and Linux operating systems: 

./r3perfagent [stop | start] 

•	 Microsoft Windows operating systems: 

r3perfagent_service [-e | -s] 

Monitoring System-Performance Remotely 

The SPI for SAP includes a feature which allows you to extend the scope of the SPI for SAP 
performance monitor to monitor the health of additional, remote SAP servers (which are not 
managed nodes) from an SAP server, which is already configured as an HPOM managed node. 

Although the remote host is not an HPOM managed node, it must still be present in 
the HPOM node list. If you do not add the remote host to the HPOM node list, HPOM 
cannot resolve the host name associated with the remote host and, as a consequence, 
messages from the remote host do not appear in the HPOM console. 

To make use of the remote-monitoring feature provided by the SPI for SAP, for example; to 
collect SAP performance metrics from an SAP System running an operating system that is 
not supported by the SPI for SAP, you need to use the r3perfconfig command to manually 
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add an additional datasource for each SAP System you plan to monitor remotely and then 
activate the RemoteMonitoring keyword (by removing the leading hash symbol “#”) in the 
r3perfagent.cfg file on the local managed node, where the performance monitor runs. 
Activating Remote Performance Monitoring shows an excerpt from the global 
r3perfagent.cfg file with the remote-monitoring feature enabled; the local 
r3perfagent.cfg file, if present, would only contain references to the managed node on 
which the local configuration file is located. 

Activating Remote Performance Monitoring 

#-----------------------------------------------------------
# Remote LocalHost RemoteHost 
# Monitoring 

RemoteMonitoring =sapwolf2 =sapprod1 
RemoteMonitoring =sapwolf3 =sapprod2 
RemoteMonitoring =sapper =sapprod3
#-----------------------------------------------------------

For more information about remote performance monitoring, see the section about 
performance monitors in the HP Operations for Windows Smart Plug-in for SAP 
Administrator’s Online Help. 

The Performance-Monitor Scheduler 

The performance agent uses an internal scheduler to ensure that the performance monitors 
run according to the desired schedule. The scheduler keeps track of time and the number of 
runs that have been completed and uses this information to ensure that the performance 
monitors run at the correct time and collect the appropriate performance-related data. 

For more information about the Performance-monitor scheduler, see the section about 
performance monitors in the HP Operations for Windows Smart Plug-in for SAP 
Administrator’s Online Help. 

Managing the Performance Agent 

The SPI for SAP performance monitor can be controlled either by using command-line options 
which differ according to the platform and operating system, or the tools that are installed by 
the SPI for SAP. For more information on either of these topics, see the following sections: 

• Command-Line Options on page 90. 

• SPI for SAP Tools on page 91. 

Command-Line Options 

On UNIX and Linux operating systems, you can use the r3perfagent command to manage 
the SPI for SAP performance monitor. The r3perfagent command accepts the following 
command-line options: 

r3perfagent [start | status | stop] 

• start - to start the SPI for SAP performance monitor 
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• stop - to stop the SPI for SAP performance monitor 

• status - to determine the current status of the SPI for SAP performance monitor 

On Microsoft Windows operating systems, you can manage the SPI for SAP performance 
monitor with the r3perfagent_service command, which accepts the following 
command-line options: 

r3perfagent_service -e -i -s -u 

-e stops the service


-i registers the service


-s starts the service


-u de-registers the service


Note that on Microsoft Windows operating systems, you can control the r3perfagent
services from the services dialog, which you can access in the Microsoft Windows 
control panel. 

SPI for SAP Tools 

Table 5 lists the tools that are available for the SPI for SAP performance monitor and shows 
which tools appear in which SPI for SAP tool group, for example: SAP R/3 NT or SAP R/3 
UN*X. 

Table 5 Performance Monitor Tools 

Application Name SAP R/3 NT SAP R/3 UN*X 

PerfAgt START • • 

PerfAgt STOP • • 

PerfAgt STATUS • 
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9 Using the Smart Plug-in for SAP

After you install and configure the Smart Plug-in for SAP you can begin to use it to monitor 
your SAP environment. As soon as you deploy the SPI for SAP policies and instrumentation, 
you begin to see SAP-related messages in the HPOM console. 

This chapter provides an overview of the components which the SPI for SAP integrates into 
HPOM and describes the steps and procedures that you need to perform if you want to run a 
typical SPI for SAP session. 

SAP Administration Tools 

The SAP R/3 Admin group includes tools for administrative functions such as writing SAP R/ 
3 statistical records and activating alerts. The following table lists the tools which appear in 
the SAP R/3 Admin tool group and describes briefly what each of the tools does. 

For more information about editing and distributing monitor configurations, see the HP 
Operations for Windows Smart Plug-in for SAP Administrator’s Online Help. 

SPI for SAP Tools for SAP Managed Nodes 

The SPI for SAP provides a wide range of tools for administrators of HPOM managed nodes 
which host SAP Systems running on either UNIX or Microsoft Windows operating systems. 
Some of the tools included in the SAP R/3 UN*X and SAP R/3 NT tools groups allow direct, 
context-sensitive access to SAP through SAP’s native graphical user interface. For example, if 
you want to investigate a performance alert, you can run the Performance tool, which starts 
the SAP GUI and displays an SAP performance-analysis window. 

First select the SAP managed node(s) on which you want the tool to run. Make sure 
you select the tool from the tools group that corresponds to the managed node’s 
operating system, for example; UNIX. Note that SPI for SAP tools cannot start a SAP 
GUI on an SAP System, which is monitored remotely from an HPOM managed node. 

For more information about the tools that access data on the managed nodes, see Accessing 
Data on SAP Managed Nodes on page 95. 

Using the Smart Plug-in for SAP Tools 

Expand the Tools > SPI for SAP item in the HPOM console to display in the details pane 
the tools and tools groups installed by the Smart Plug-in for SAP. During installation and 
setup, the Smart Plug-in for SAP adds the following tool groups to the HPOM console: 
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•	 SAP R/3 Admin 

•	 SAP R/3 NT 

•	 SAP R/3 UN*X 

Since most SPI for SAP tools make use of the SAP GUI, make sure that the SAP 
GUI is available on the HPOM management server and, in addition, on any 
machine where an HPOM console runs. For more information, see Installing the 
SAP GUI on page 25. SPI for SAP tools cannot start an SAP GUI on an SAP 
System, which the SPI for SAP is monitoring remotely from an HPOM managed 
node. 

To launch a Smart Plug-in for SAP tool 

1	 Expand the tool group containing the tool you want to launch. 

2	 Right click the tool you want to launch and select the following option from the menu 
which pops up: 

All Tasks > Launch Tool... 

3	 In the window which appears, select the SAP nodes on which you want to run the Smart 
Plug-in for SAP tool and click the Launch... button. 

R/3 Info is one of a number of tools which display information in the Tool Output pane of the 
Tool Status dialog illustrated in Figure 9. For more information about the R/3 Info tool, see 
Accessing Data on SAP Managed Nodes on page 95. 

Figure 8 Context-Sensitive Access to SAP 
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The majority of SPI for SAP tools provide context-sensitive access to SAP by starting the SAP 
GUI and calling the appropriate SAP transaction. For example, Figure 8 on page 94 shows the 
window that appears when you launch the Syslog tool, which you can find in the SAP R/3 
UN*X and SAP R/3 NT tool groups. 

Accessing Data on SAP Managed Nodes 

The following SPI for SAP tools provide quick access to SAP-related information from the 
selected managed node. The R/3 Info and Java R/3 Frontend tools are available on both UNIX 
and Linux operating systems and Microsoft Windows operating systems, too; some other tools 
are available on UNIX and Linux operating systems only. 

Each of the tools in the following list is explained in greater detail in the sections which follow. 

•	 Check R/3 Database 

Establishes a connection to the SAP database server and provides a quick way of checking 
the database connection. If multiple instances are installed, the tool prompts you to enter 
the System ID in which the database you want to check resides. 

•	 R/3 Info 

Returns the following information for SAP R/3 instances on a selected node: 

—	 host name 

—	 SAP System name 

—	 SAP instance name and number 

—	 list of processes for the selected instance 

The R/3 Info tool collects and uses the same information as r3disc, the SPI for SAP’s 
service- discovery policy. However, note that the R/3 Info tool displays the information it 
collects; it does not use the information to generate a service tree. For more information 
about the r3disc policy and Service Views in general, see HP Operations for Windows 
Smart Plug-in for SAP Administrator’s Online Help. 

•	 Java R/3 Frontend 

Uses the local SAP GUI utility (running on the HPOM management server) and profile to 
connect to the desired SAP system. 

•	 Status R/3 Config 

Displays a list of all SAP NetWeaver Systems (and the functional modules per System) 
present on the selected managed node. In addition, it lists all established SAP processes 
and indicates their current status. 

For example, launching the R/3 Info tool displays a dialog similar to the one illustrated in 
Figure 9. The Tool Status dialog indicates which command is being executed, on which node, 
and the command’s current status. 
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Figure 9 Output from the R/3 Info Tool 

The Status R/3 Config tool runs on the selected managed node and displays the current local 
SAP configuration. It lists all SAP systems installed on the selected node and the functional 
modules installed per SAP System. In addition, the R/3 process status provides a list of all 
established SAP processes and their current status. 
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Figure 10 R/3 Configuration Status Window 
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Working with SAP Messages 

The message browser in the HPOM console is an important source of information about the 
status of the SAP servers, for which you are responsible. If you log in to HPOM as an user 
with SAP responsibilities, the message browser displays, among others, messages from SAP 
R/3 and Netweaver servers, which you are monitoring with the SPI for SAP. 

You can use the SPI for SAP to monitor SAP instances running on a remote host, 
where the SPI for SAP is not available. Although the remote host is not an HPOM 
managed node, it must still be present in the HPOM console. If you do not add the 
remote host to the HPOM console, HPOM cannot resolve the host name associated 
with the remote host and, as a consequence, will not be able to display any messages 
from the remote host in the console. 

Selecting and double-clicking a message in the message browser displays the selected 
message’s properties and allows you to perform the following tasks: 

•	 View a detailed description of a problem 

•	 View instructions designed to help you solve the problem to which the message relates 

•	 Initiate a pre-defined action, attached to a message 

•	 Add an annotation to a message in order to document the actions you took to solve a 
problem 

•	 Acknowledge a message so that it is moved to the acknowledged-messages database 

The following example shows a typical sequence of events which occur when a critical 
message appears in the HPOM console. 

1	 In the active-messages browser, locate and double-click the critical message sent by the 
SPI for SAP. 

HPOM displays the message’s text property sheet by default. 

2	 Click the Instructions tab to see if any instructions have been provided to help you sort 
out the problem that has been reported. 

3	 After you have read and understood the information provided in the Instructions tab, click 
the Commands tab to see if an automatic or an operator-initiated action is available to 
help solve the problem reported by the incoming message. In many cases, the SPI for SAP 
uses these actions to provide context-sensitive access to SAP and automatically displays 
the appropriate SAP transaction window. 
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Figure 11 Message Details 

4	 If an operator-initiated action is available, click the Start button in the 
Operator-initiated field of the Commands property sheet to launch it. You can watch the 
progress of the action in the Status field. In the message field, the action starts the SAP 
GUI and displays the Workload- analysis transaction illustrated in Figure 12. 

5	 Click the [<server_name>] button indicated in the This Application Server field and use 
the tools available with SAP to solve the problem. 

6	 When you have finished, log out of SAP and return to the Message Details window. 

7	 Click Acknowledge to confirm that you are aware of the message to which you just 
responded. As soon as you acknowledge the message, the message moves from the 
active-messages browser to the acknowledged-messages browser. 
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Figure 12 SAP Performance: Workload Analysis 
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10 Integrating the SPI for SAP with HP Reporter

This section introduces the concept of service reports and explains how to use them in 
conjunction with the SPI for SAP and HPOM. The information in this section is designed 
specifically to help you use the service reports to manage the SAP environment in an efficient 
and convenient manner. 

Service Reports 

Service reports are web-based reports that are produced by HP Reporter (Reporter) using 
default templates and viewed using a web browser. Reporter allows you to request both 
scheduled and on-demand versions of reports. 

SPI for SAP service reports correlate the data extracted from either the HP Software 
Embedded Performance Component (CODA) or the HP Performance Agent. You can use the 
correlated data to generate reports which display short-, medium-, or long-term views of your 
IT environment and supplement the detailed, real-time graphs that the Performance 
Manager provides. The combination of reports and graphs is a powerful tool for trend 
analysis. For example, you can: 

•	 Identify potential bottlenecks in your IT system, so that you can take action before 
problems become acute. 

•	 Use the information to help you to make accurate predictions for future upgrades. 

•	 Collect accurate information to be used in measuring service levels. 
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Figure 13 SPI for SAP Service Reports 

Upgrading the SPI for SAP Reports 

If you are upgrading to version 11.10 from earlier versions, you can continue to use existing 
data and monitors. 

Upgrading the SPI for SAP reports in the manner described in this section removes 
from the Reporter system all old report data collected by the SPI for SAP. However, 
you can use database tools to preserve the tables containing information that you 
want to use after completing the upgrade process. For more information, see the 
documentation provided with the database product. 

1 Remove the old SPI for SAP reporter-integration package using the standard Microsoft 
Windows software-removal method: 

Start: Settings > Control Panel > Add/Remove Software 

2 Install the new SPI for SAP reporter integration as described in Installing the SPI for 
SAP Reports on page 103. 
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Installing the SPI for SAP Reports 

This section explains how to install the SAP service report which come with the SPI for SAP 
and, in addition, provides information designed to help you prepare for the installation. 

Before You Begin 

Before you install and setup the SPI for SAP service reports, you must complete the following 
tasks: 

1	 Make sure either the HP Software Embedded Performance Component or the HP 
Performance Agent is running on all SAP managed nodes for which you want to generate 
service reports. 

2	 Make sure HP Reporter is available on a Microsoft Windows host. 

HP Reporter lite is no longer bundled with HP Operations Manager; you must 
install and use the full version of the HP Reporter to view SPI for SAP reports. 

You can install HP Reporter either on the HPOM management server or, to improve 
overall performance, on a separate system dedicated to the generation and display of 
service reports. 

3	 Make sure the SPI for SAP R/3 Performance Agent is available and configured on the 
machines for which you want to generate reports. 

4	 If you want to edit existing (or create new) service reports for the SPI for SAP, make sure 
that Crystal Reports is available on the machine hosting the HP Reporter. 

Installing SAP Service Reports 

The SPI for SAP inserts the SAP service reports into the HP Reporter product as a snap-in 
package using InstallShield. This means that the HP Reporter must already be installed 
before you install the SPI for SAP service reports. During set-up of the SPI for SAP service 
reports you will be asked to confirm or specify the common application path for HP Reporter. 

The common application path is the folder where HP Reporter is installed. The set-up 
attempts to discover this path automatically, and in most circumstances you should 
avoid changing it. 

The set-up copies components to the directories listed in Table 6. All directory paths are 
relative to the Reporter common-installation path. 

Table 6 Locations of SPI for SAP Service-Reports Components 

Component Directory 

Installation script 

Configuration files 

%OvInstallDir%\newconfig\ 

SAP report template files %OvReporter%\data\reports\SAP 
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To Install HP Reporter on the HPOM Management Server 

To be able to generate and view service reports for the SAP Systems you are monitoring with 
the SPI for SAP, you first need to install the full version of the HP Reporter. You can install 
the HP Reporter either on the HPOM management server or, alternatively, on a separate 
machine, which is not the HPOM management server. For more information about installing 
the HP Reporter, see the HP Reporter product documentation. After you install and configure 
the HP Reporter, you need to install and configure the SPI for SAP reports package on the 
same machine. 

If you install the HP Reporter on a machine which is not the HPOM management 
server, make sure the machine on which you install the HP Reporter can see the 
HPOM managed nodes, for which you want to generate service reports. 

To Install the SPI for SAP Reports 

The information in this section describes the steps required to add the SPI for SAP 
service-reports to an existing HP Reporter installation. When you have completed this task, 
the SPI for SAP service reports will be available in the HP Reporter GUI, and you will be able 
to use them to generate SAP-specific service reports, which you can view in a web browser. 

1	 Make sure that the HP Reporter is installed and configured on the machine where you 
want to install the SPI for SAP service reports. 

2	 Insert the HP Operations Smart Plug-ins media into the DVD drive of the machine where 
you installed and configured the HP Reporter. 

3	 Browse to the following folder: 

SPIs\SAP SPI Reporter Package 

4	 Locate, select, and run the following file: 

sapspi_reporter.msi 

5	 Follow the instructions to complete the installation. 
104	 Chapter 10 



Figure 14: SPI for SAP Reports InstallShield Wizard. 

Configuring Report Packages 

The set-up process of the SPI for SAP’s service-report integration automatically performs the 
following tasks: 

•	 Creates new report group: SAP_R3 

•	 Assigns new metric list to the new SAP_R3 group 

•	 Assigns new group report to the SAP_R3 group 

•	 Assigns new system reports to the SAP_R3 group 

To Configure Report Packages 

1	 Verify that the installation of the SPI for SAP service reports completed successfully by 
confirming that the set-up process created the report and metrics groups listed in 
Configuring Report Packages on page 105. 

2	 In the Reporter console, browse to the Configure Report Packages window using the 
following menu option: 

File > Configure > Report Packages 

Check that the following package is present in the list of installed packages. 

•	 SPI for SAP 

3 If you choose to add SAP Systems manually to the HP Reporter, note that you can use the 
following values in the Add System window: 

System host.name.com 

Network SAP 
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Domain "SAP" as appropriate 

Check that the set-up process added your SAP NetWeaver host to the appropriate 
Reporter group, namely; SAP_R3. The set-up process automatically assigns hosts to a 
report group according to the kind of data source (SAP NetWeaver), which it discovers on 
the monitored host. 

4 Click OK; the systems appear in the Reporter’s details pane. 

5 Use the Reporter GUI to schedule the generation of the SPI for SAP reports or generate 
them now using the option indicated below and illustrated in Figure 15 on page 106: 

Actions > Run > Generate Reports 

Figure 15 SPI for SAP Reports and Metrics 
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Removing the SPI for SAP Reports 

To completely remove the SPI for SAP reports, you need to perform the following steps in the 
order specified: 

•	 To Remove Reporter Snap-in Packages on page 107. 

•	 Removing Binaries from the HP Reporter System on page 107. 

To Remove Reporter Snap-in Packages 

1	 In Reporter, browse to: 

File > Configure > Reporter Packages 

2	 Select the following files from the Installed Packages window located in the right pane of 
the Configure Report Packages window: 

•	 SPI for SAP 

3	 Double-click the left arrow button to remove the selected packages from the Available 
Packages window: the selected packages appear in the list of Available Packages in the 
left pane of the Configure Report Packages window. 

4	 Click OK to finish. 

Removing Binaries from the HP Reporter System 

1	 Go to the HP Reporter system. 

2	 Insert the HP Operations Smart Plug-ins media into the DVD drive of the machine where 
you installed and configured HP Reporter. 

3	 Run the HP Operations Smart Plug-ins wizard to remove programs. 

4	 Select Remove Products. 

5	 Select Reports under SAP SPI, and then follow the on-screen instructions to complete the 
deinstallation process. 
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11 Troubleshooting

This section describes the troubleshooting services feature for the SPI for SAP. The 
troubleshooting services feature provides tools that enable you to collect quickly and easily all 
the system and application data that you need to begin investigating problems that occur 
when using an HP software application. 

To use the troubleshooting services with the Smart Plug-in for SAP, you need to trigger the 
collection of the data required for troubleshooting manually and save the collected data to a 
file. You can then review the contents of the file containing the collected data and, if necessary, 
send a copy of the file by e-mail to the support engineers. 

The SPI for SAP provides the following troubleshooting tools: 

• Self-Healing Info 

Use the Self-Healing Info tool to manually trigger the collection of the data required for 
troubleshooting. For more information about the data-collection process, see To trigger 
data collection for troubleshooting services on page 110. 

• Version Verify 

The Version-Verify tool compares the base version of the SPI for SAP installed with the 
version of any SPI for SAP components installed on the system. For more information 
about verifying installed software versions, see To check the version of the installed 
product components on page 111. 

Self-Healing Info Tool 

This tool can be run on any managed node managed by the SPI for SAP. When the tool is 
running it gathers data that you can send to HP support to diagnose the SPI problem. 

This tool is bundled along with each Smart Plug-in and is installed automatically in the 
Smart Plug-in Tools group. The tool has the capability of gathering troubleshooting data. 
After you run the tool and save the data to a file, you must contact HP support and email the 
file to them according to their instructions. 

To deploy SPI-SHS Instrumentation (as needed): 

1 At the HPOM console, select the right-click the node(s) on which you want to run the tool. 

2 Select All Tasks Æ Deploy instrumentation. 

3 Select the SAP Instrumentation and SHS Data Collector. 

4 Click OK. 

To use the tool: 

1 At the HPOM console, select Tools ëÆ SPI for SAP. 

2 Locate the Self-Healing Info tool, right-click it and select All TasksÆLaunch Tool... 
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3 Select the node on which to deploy the tool and click Launch... 

4 In the message that appears, note the file name and location where the gathered data is 
saved; then contact support for instructions on where to email it. 

To trigger data collection for troubleshooting services 

1 In the HPOM console, expand the SPI for SAP tool group containing the tool you want to 
launch, for example for UNIX and Linux managed nodes: 

Tools > SPI for SAP > SAP R/3 UN*X 

2	 Locate and right click the Self-Healing Info tool and select the following option from the 
menu which pops up: 

All Tasks > Launch Tool... 

3	 In the window which appears, select the SAP nodes (or groups of nodes) on which you 
want to run the troubleshooting services data-collection tool and click Launch... 

4	 The collected data is stored in the following file, which you will need to forward to the 
support engineers for evaluation: 

•	 UNIX and Linux operating systems: 

/tmp/SPI_MYSAP_support.tar 

•	 Microsoft Windows operating systems: 

C:\WINDOWS\TEMP\SPI_MYSAP_support.zip 

You can follow the status of the data-collection progress by monitoring the output, which is 
displayed in the Tool-Output pane at the bottom of the Tool Status dialog, as illustrated in 
Figure 16 on page 110. 

Figure 16 Collecting data for troubleshooting services 
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To check the version of the installed product components 

1 In the HPOM console tree, expand the tool group containing the tool you want to use 
verify product version information: 

Tools > Self Healing 

2 Locate and right click the Version Verify tool and select the following option from the 
menu which pops up: 

All Tasks > Launch Tool... 

3 In the dialog which appears, select the SAP nodes (or groups of nodes) on which you want 
to run the troubleshooting services, Version-Verify tool and click Launch... You can 
follow the status of the verification progress by monitoring the output, which is displayed 
in the tool-output pane, as illustrated in Checking the Installed Software Versions on 
page 111. 

Figure 17 Checking the Installed Software Versions 
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12 Uninstalling the SPI for SAP

This section describes how to uninstall the SPI for SAP software quickly and cleanly. You need 
to perform the following tasks, as appropriate, on either the SAP managed nodes or the 
HPOM management servers on which you installed the SPI for SAP software. 

Removing the SPI for SAP Objects from Managed Nodes 

Apply the removal transport from the R3Trans.car file on all the SAP nodes to remove all 
objects added by the SPI for SAP. See Applying the SAP Transports on page 29 for 
information on applying an SAP transport. 

Removing SAP-management Functionality from Managed Nodes 

To de-assign SAP management functionality from HPOM managed nodes: 

1	 On each managed node where you installed the SPI for SAP performance monitor, follow 
the corresponding deinstallation instructions in Uninstalling the SPI for SAP 
Performance Packages on page 81. 

2	 Remove the SPI for SAP policies from the SAP NetWeaver managed node. 

a In the HPOM console, locate and expand the following policy group: 

Policy Management > Policy Group > SPI for SAP > en 

b	 Select and right click the SPI for SAP policy group and remove the policies by using 
the following option: 

All tasks > Uninstall from... 

c	 In the Uninstall Policies from... window which appears, select the managed nodes 
from which you want to remove the SPI for SAP policies as illustrated in Figure 18 
and click OK. 
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Figure 18 Uninstalling SPI for SAP Policies 

d	 Verify that the polices have indeed been removed from the SAP managed nodes by 
selecting and right-clicking the managed node in the console tree and using the 
following option in the pop-up menu, which appears: 

View > Policy Inventory 
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Uninstalling the SPI for SAP using the DVD 

1 Insert the HP Operations Smart Plug-ins DVD in the DVD drive. 

2 Select the Remove products to proceed to the product selection dialog. 

3 In the Product Selection dialog, select SAP SPI and click Next. 
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Figure 19 InstallShield Wizard Removal Dialog 

The SPI for SAP does not appear on the first page of installed product components; 
click Next to scroll through the list of components to remove, as shown in 
Figure 19 on page 116. 

4 Click Remove to uninstall the SAP SPI. 

5 In the HPOM console, remove manually any remaining SPI for SAP GUI components, for 
example: 

• Remove any configuration-file policies you have added. 

• Remove any policy groups you have created. 
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Uninstalling the SPI for SAP using the Windows Control Panel 

1 In the Windows control panel, use the Add or Remove Programs tool to start the removal 
process; select HP Operations Smart Plug-ins from the list of installed programs and click 
Change. 

2 In the HP Operations Smart Plug-ins InstallShield Wizard which opens, click Next and 
read the instructions displayed. 

3 Click Next again to open the Program Maintenance dialog, which you can use to install 
and remove HP Operations programs. 

4	 Check the Remove Products option and click Next to open a dialog which asks you to select 
the product you want to remove. 
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A Using a Non-Privileged Windows User with the 
SPI for SAP 
By default, the SPI for SAP tools and policies run under the $AGENT_USER account that has 
been configured with HP Operations Manager (HPOM) for Windows while adding the SAP 
node to the management server. If you use an HP Operations agent version that supports the 
use of a non-privileged user, $AGENT_USER does not need to be an administrative user. 

To use a non-privileged Windows user with the SPI for SAP, follow these steps: 

1	 Install the HP Operations agent on the managed node. Refer to the Manual Agent 
Installation or Remote Agent Installation section in the HPOM online help for more 
information. 

2	 Change the default agent user (Local System) to a non-privileged user. Refer to the 
Change the user of an HTTPS agent on a Windows node section of the HPOM online help 
for more information. 

Additional Requirements 

While using a non-privileged user as $AGENT_USER with the SPI for SAP, the following 
policies and tools must be provided with the user credentials of a user with additional 
privileges: 

•	 PerfAgt START and PerfAgt STOP tools: You must provide these tools with the rights 
to be able to start or stop the SPI for SAP R/3 Performance Agent service. Alternatively, 
you can enable the non-privileged user—which you plan to use as $AGENT_USER—to be 
able to start and stop the SPI for SAP R/3 Performance Agent service. 

•	 Install Performance Package (Windows) and Remove Performance Package 
(Windows) tools: You must use the Install Performance Package (Windows) and Remove 
Performance Package (Windows) tools with an administrative user. 
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